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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,309,528; 5,440,348; 
5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,577,190; 5,584,006; 5,640,601; 5,644,364; 5,654,737; 5,724,605; 5,726,717; 
5,745,637; 5,752,029; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,959,610, 5,986,584; 5,999,406; 
6,038,573; 6,057,829, 6,069,668; 6,141,007; 6,211,869; 6,336,093, 6,532,043; 6,546,190; 6,596,031;6,728,682, 6,747,705; 
6,763,523; 6,766,357; 6,847,373; 7,081,900; 7,403,561; 7,433,519; 7,441,193, 7,671,871; 7,684,096; 7,836,389 and 7,916,363; 
7,930,624; 8,023,568; 8,082,226; 8,154,776; D352,278; D372,478; D373,778; D392,267; D392,268; D392,269; D395,291; 
D396,853; D398,912. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 0674414; 
0752174; 0811290; 0811292; 0811293; 1050048; 1111910; 1629675, and 0972256. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Interplay Assist may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document 
is supplied as a guide for Interplay Assist. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without 
notice.

Copyright © 2015 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.
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The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid Remote 
Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Axiom, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, Conectiv, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, Dazzle Digital Video Creator, D-Command, D-Control, Deko, 
DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, 
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, 
DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, 
DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, 
Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame 
Chase, FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE 
HDCAM, iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording 
Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, 
KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, Luna, MachineControl, Magic Mask, 
Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, M-Audio, M-Audio Micro, 
Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, Media Reader, Media Recorder, MEDIArray, 
MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, Mix Rack, MixLab, Moviebox, Moviestar, 
MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF 
Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, 
Personal Q, PET, Pinnacle, Pinnacle DistanTV, Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile 
Media, Pinnacle Scorefitter, Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory, 
PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay, 
SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, SPACEShift, 
SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, Studiophile, SubCap, 
Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, SYNC I/O, Syntax, TDM 

http://www.apache.org/
http://jcifs.samba.org/
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FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In 
Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, Torq Xponent, Transfuser, Transit, TransJammer, 
Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, 
VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either registered trademarks or 
trademarks of Avid Technology, Inc. in the United States and/or other countries.

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

News material provided by WFTV Television Inc.

Interplay | Transfer Setup and User’s Guide • This document is distributed by Avid in online (electronic) form only, 
and is not available for purchase in printed form.

http://www.wildlifeworlds.com
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Using This Guide

Congratulations on your purchase of an Interplay® | Transfer application. You can use your 
application to move Avid assets (media and metadata) and manage the transfer of assets to and 
from workgroups in an Interplay | Production environment. You can also use Interplay Transfer 
in a standalone environment to move assets between workstations. The Interplay Transfer system 
transfers assets to and from supported third-party applications, devices, and archive integration 
systems. 

This guide contains all the task-oriented instructions, conceptual information, and reference 
material you need to transfer assets in an Interplay Production or in a standalone environment.

This guide is intended for all Interplay Transfer users, from beginning to advanced.

Date Revised Changes Made

06/26/2015 Updated for Interplay v3.3.

12/15/2014 Updated for Interplay v3.2. No new features.

6/23/2014 Updated the following:

• “Specifying Interplay | Transfer Engines for Direct Transfers” on page 59

• “Configuring OP1A/XDCAM Profiles for Catalog Checkins” on page 80

• “Writing to a Temp File with Generic FTP profiles” on page 89

10/12/2011 Updated the following: 

• “Specifying Interplay | Transfer Engines for Direct Transfers” on page 59

• Added new Force UTF-8 option to FTP Directory Profile dialog box. See “FTP 
Directory Profile Window Settings” on page 94.
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to your 
computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. Follow 
the guidelines in this document or on the unit itself when handling 
electrical equipment.

> This symbol indicates menu commands (and subcommands) in the order 
you select them. For example, File > Import means to open the File menu 
and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows only), 
(Macintosh), or (Macintosh 
only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published. You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To view 
these online versions, select ReadMe from the Help menu, or visit the Knowledge Base at 
www.avid.com/support.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/support. Online services are available 24 
hours per day, 7 days per week. Search this online Knowledge Base to find answers, to view 
error messages, to access troubleshooting tips, to download updates, and to read or join 
online message-board discussions.

Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

http://www.avid.com/support
http://www.avid.com/support
http://www.avid.com/support


1 Interplay | Transfer Overview

Interplay Transfer Engine lets you transfer Avid assets to and from another workgroup, send 
finished sequences to a configured playback device, and capture media from a configured ingest 
device.

Interplay Transfer Engine receives and queues transfer requests from one or more clients. 
Transfers are then initiated by the Interplay Transfer Engine to off load the client. 

You can monitor the status of all transfers using the Interplay Transfer Engine Status view from 
within Interplay | Access or you can monitor your own transfers from within your Avid editing 
application. You can also monitor the status of transfers using the Interplay | Production Services 
and Transfer Status software. You can designate a single Transfer Cache engine to monitor the 
transfers handled by several Interplay Transfer Engines, Avid AirSpeed® Multi Stream, or other 
Interplay Transfer Engine enabled devices.

The following topics in this chapter provide an overview of working with Interplay Transfer 
Engine:

• Understanding Interplay | Transfer Engine Configurations

• Networking Considerations

• Transfer Types

• Support for MXF/AAF Media

• Operating Points Qualified for Interplay | Transfer Playback
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Understanding Interplay | Transfer Engine 
Configurations

Interplay Transfer Engine can be configured in a workgroup or in a standalone configuration. 

Terminology

The following terminology applies to Interplay Transfer configurations:

• Avid shared storage - Avid ISIS

• Workgroup - another term for Interplay environment. A workgroup always includes an 
Interplay Engine and shared storage.

• Standalone environment - the Transfer Engine is not part of an Interplay environment 
(workgroup). A standalone environment may or may not include shared storage.

Workgroup Configurations

A workgroup enables collaborative workflows by allowing multiple editors to share media. For 
diagrams showing typical shared-storage workgroup configurations, see Interplay | Production 
Best Practices.

Your workgroup environment might consist of the following components, depending on the 
workgroup configuration:

• Interplay Engine to track and manage Avid shared storage media

• Interplay Transfer Engine to manage the transfer of media to and from the workgroup, and to 
and from other workgroups

• Supported Avid editing applications, such as Media Composer®

• Avid ISIS file server and storage.

• Ethernet® network that connects the Avid editing systems, Interplay Engine, and Interplay 
Transfer Engine server to an Avid ISIS shared storage environment

• Ethernet network used as a general-purpose communication network



Understanding Interplay | Transfer Engine Configurations

9

Supported Interplay | Transfer Configurations

Stating at Interplay v3.0, Interplay Transfer is a 64-bit application. The supported Interplay 
Transfer Engine configurations are as follows:

• A dedicated Interplay Transfer Engine server connected to Avid shared storage (Avid ISIS) 
that includes an Interplay Engine.

• Standalone Interplay Transfer Engine software installed on an Avid editing system that is 
connected to Avid shared storage without an Interplay Engine. Each networked client must 
install both the Interplay Transfer Engine software and the Interplay Transfer Engine client 
software.

n In order to perform a Send to Playback of XDCAM HD material, the Standalone Interplay 
Transfer system must be connected to Avid shared storage.

n Standalone Interplay Transfer Engine is not supported on Avid Instinct® systems.

• Standalone Interplay Transfer Engine software installed on an Avid editing system with 
local storage and no access to shared storage (Windows operating systems only).

• Starting at Interplay Production v3.0, standalone Interplay Transfer supports Windows 7 
Professional and Windows 8 Professional on Avid Media Composer systems:

When installing a standalone Interplay Transfer client on one of these Avid editing systems, 
the location of the TMClient.ini file varies depending on the operating system of the Avid 
editing system. See “Location of Interplay | Transfer Files” on page 11.

Background Processes for Interplay | Transfer

Starting at Interplay Transfer v3.0, Interplay Transfer runs the following as background 
processes:

• Playback

• Ingest

• DET

This technique is also referred to as “out of proc.” (out of process). The system creates a separate 
process for each playback, ingest, or DET job. One of the benefits of running these as 
background processes is that if one of these jobs hangs or crashes it only affects that particular 
job and does not affect the Interplay Transfer Engine.

If a background process hangs it is designed to automatically shut down after a certain period of 
time (usually less than one minute) if it can’t connect to the Interplay Transfer Engine.
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The following illustration shows the background processes running in the Windows Task 
manager.

You normally do not need to be concerned about these processes. They are added here for 
troubleshooting purposes.
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Location of Interplay | Transfer Files

The location of the Interplay Transfer files depends on the location selected during the 
installation process. The tables in this section provide the default locations. If you have any 
problems locating the files, you should use the Microsoft Windows Search tool.

The following table list the locations for Interplay Transfer files on an Interplay Transfer Engine 
system.

The following table list the locations of the Interplay Transfer files on an Interplay Transfer 
client system.

Files on Interplay Transfer 
Engine System Locationa

a. The Application Data folder is a hidden folder in Microsoft Windows. To view this folder you need to change the 
View settings in the Folder Options dialog box.

Interplay Transfer log files C:\Documents and Settings\
All Users\Application Data\Avid\Temp\TMServerLog

TMserver.ini C:\Documents and Settings\All Users\
Application Data\Avid\Avid Interplay Transfer Engine

Files on Interplay Transfer 
Client System Locationa

a. The Application Data folder is a hidden folder in Microsoft Windows. To view this folder you need to change the View 
settings in the Folder Options dialog box.

Interplay Transfer Client log files (Windows 7 and Windows 8) C:\ProgramData\Avid\

TMClient.ini When installing an Interplay Transfer client on a supported Avid editing 
system, the location of the TMClient.ini file varies depending on the 
operating system and type of Avid editing system.

Standalone Interplay Transfer Engine files

Interplay Transfer log files (Windows 7 and Windows 8) C:\ProgramData\Avid\Temp\TMServerLog

TMserver.ini (Windows 7 and Windows 8) 
C:\ProgramData\Avid\Avid Interplay Transfer Engine
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Networking Considerations

For two workgroups to cooperate, some workstations in one workgroup must have access to 
services in the other workgroup. If these workgroups are not in the same site, or are separated by 
routers or firewalls, you have to establish access to allow these services to work together.

The main components are an Interplay Engine and two Interplay Transfer Engines. All these 
services are TCP/IP based.

• The Interplay Engine leverages the standard HTTP service on port 80. 

• The Interplay Transfer Engines use port numbers that are defined in the services file in 
\WINDOWS\SYSTEM32\DRIVERS\ETC\. As installed, these port numbers are as follows:

- 6532 - the Interplay Transfer Engine listens on this port for requests from other TM 
servers (for example, initiating a workgroup transfer).

- 6535 - This is the default port used by the Interplay Transfer Engine for connecting to 
playback servers (for example, AirSpeed Multi Stream).

- 6539 - The Interplay Transfer Engine listens on this port for incoming requests from the 
Transfer Client.

Interplay Transfer uses ports 6432 and 6535 to communicate with the sending or receiving 
device. After the Transfer Engine establishes the connection, the OS on the external device 
assigns a port and notifies the Transfer Engine of the new port number. Then the external device 
starts listening on that port. Transfer Engine uses the new port number for sending or receiving 
data.

Remote Workgroup Connectivity Rules

For minimal remote workgroup connectivity, the following rules apply:

• Avid editing clients must be able to access the remote Interplay Transfer Engine server and 
Interplay Engine services.

• Interplay Transfer Engine servers must be able to access the remote Media Transfer service. 
Interplay Transfer Engine servers access only workgroup-local Interplay Engine services, 
not remote ones.

• The Interplay Engine must be able to access the remote Interplay Transfer Engine service.
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Typical Configuration

The following figure shows a typical configuration.

In the above illustration, the term “Interplay Production Server” refers to the Interplay Engine.

Remote Workgroup Network Configuration

The figure in “Typical Configuration” on page 13 shows only one Avid editing client per 
workgroup. You should assume that there are more clients and that each client requires the same 
connectivity. To access Interplay Transfer Engine when network traffic is restricted at the 
router/firewall point, the network administrator must enable the combinations listed in the 
following table.

Use the following table to verify which port numbers to use, depending on your source and 
destination.

Remote Workgroup Network Connection Guidelines 

Source Destination Port

EditingClient_A_1 Interplay Production Server_B http:80

EditingClient_A_1 Interplay | Transfer Server_B 6539
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Any additional Avid editing clients should follow the rules listed in “Remote Workgroup 
Connectivity Rules” on page 12.

Transfer Types
When you use Interplay Transfer Engine in a workgroup environment, you can use several types 
of transfers.

• You can perform a transfer from within the Avid editing system (for example, NewsCutter) 
to another workgroup or playback device. See “Transferring Avid Assets from an Avid 
Editing Application” on page 117.

• You can perform a remote transfer from the Interplay Access user interface. See 
“Transferring Avid Assets from Workgroup 4.5 to an Interplay | Production Workgroup” on 
page 120.

• You can capture media from a configured ingest device to your Avid editing application bin. 
See “Transferring Files From an Ingest Device” on page 128.

• If you are working in a broadcast environment, you can transfer finished sequences to a 
configured playback device. See “Transferring Avid Assets to a Playback Device (Send to 
Playback)” on page 124.

• You can import and export MXF OP1a files into an Avid ISIS, or an Avid editing 
environment from an FTP server. See “Transferring To and From Generic FTP Servers” on 
page 130.

EditingClient_B_1 Interplay Production Server _A http:80

EditingClient_B_1 Interplay | Transfer Server _A 6539

Interplay Production Server _A Interplay | Transfer Server _B 6539

Interplay Production Server _B Interplay | Transfer Server _A 6539

Interplay | Transfer Server_A Interplay | Transfer Server _B 6532

Interplay | Transfer Server _B Interplay | Transfer Server _A 6532

Remote Workgroup Network Connection Guidelines 

Source Destination Port
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• You can capture media from FTP video servers. See “Transferring Files From FTP Deck 
Devices” on page 135.

• You can perform transfers from an Interplay Production environment to an Avid Unity 
MediaManager v4.5 MXF workgroup environment that includes Avid editing systems 
supported in an Interplay Production environment. See “Transferring Avid Assets from an 
Interplay | Production Workgroup to Another Workgroup” on page 117.

n Transfers from Interplay Production to MediaManager v4.5 OMF® workgroups are not 
supported.

• You can drag and drop from Avid Unity MediaManager v4.5.x workgroup to an Interplay 
workgroup if you are going from the MediaManager browser to a standalone Interplay 
Access or to an Interplay Window. See “Transferring Avid Assets from Workgroup 4.5 to an 
Interplay | Production Workgroup” on page 120.

• You can edit media during the capture process. See “Using Frame Chase Editing” on 
page 142.

• You can create an AutoTransfer folder with a Transfer Preset to automatically transfer assets 
to the Interplay Transfer Engine for workgroup-to-workgroup transfers. See “Automatically 
Transferring Assets to Another Workgroup” on page 121.

Support for MXF/AAF Media
MXF media created and edited in an Avid editing application can be shared in an Interplay 
Production environment with other Avid MXF-capable devices. For a description of compatible 
issue between the various Avid products when working in an Interplay workgroup, see 
Interplay | Production Best Practices.

c Any third-party video servers included in an Interplay Transfer Engine workgroup must 
support integration with an Avid MXF workgroup. Check with the manufacturers of the 
third-party video servers to verify that your video servers support Avid MXF workgroups. 

Operating Points Qualified for Interplay | Transfer 
Playback

Due to variations in FTP servers, Avid cannot guarantee that the GENERIC_FTP and OP1A 
_EXPORT profiles will work with all FTP servers. In addition to specific playback devices, we 
have also tested with FileZilla and Linux Vsftpd FTP servers.
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Note that the GENERIC_FTP_PROFILE and the OP1A_EXPORT_PROFILE expect that the 
files on the FTP server will have an ".mxf" extension, and that these profiles will not work with 
servers that don't.

The Grass Valley K2 does not use MXF extensions and the OP1A_EXPORT_K2 profile was 
created to handle that and other differences with that server. This profile may work with other 
servers that don't use the extension, but this cannot be guaranteed and it is best to try it first. 

Generic FTP Profile - DHM Workflows

The following table lists the operating points qualified for Interplay Transfer Generic FTP 
playback.

n Note that Avid has not qualified AVC-Intra FTP for any specific video servers. Support is for 
Generic FTP only.

Generic_FTP_Profile - DHM Workflows

Format Ingest Playback W
H 
NTSC/PAL

Interlaced / 
Progressive

Frame 
Rate 
NTSC/PAL

DV 25, DV50 Yes Yes 720 480/576 Interlaced 25, 29.97

IMX 30, IMX 40, IMX 50 Yes Yes 720 486/576 Interlaced 25, 29.97

DNxHD 100 Yes Yes 1440 1080 Interlaced
Progressive

25, 29.97

DNxHD 444 Yes Yes 1920 1080 Progressive 25, 29.97,
50, 59.94

DNxHD 1080 175X-185X-220X 1 Field Yes Yes 1920 1080 Progressive 23.976, 24, 
25, 29.97, 
50, 59.94

DNxHD 1080 175-185-220 1 Field Yes Yes 1920 1080 Progressive 23.976, 24, 
25, 29.97, 
50, 59.94

DNxHD 1080 115-120-145 1 Field Yes Yes 1920 1080 Progressive 23.976, 24, 
25, 29.97, 
50, 59.94

DNxHD 1080 36 Yes Yes 1920 1080 Progressive 25, 29.97,
50, 59.94
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OP1A Export to Omneon Spectrum and Grass Valley K2

Avid has qualified the supported XDCAM HD formats with the Omneon Spectrum and Grass 
Valley K2 servers.  OP1A_EXPORT profile was used for Omneon playback, 
OP1A_EXPORT_K2 was used for K2 playback, and GenericFTP was used for ingest.

DNxHD 1440 Yes Yes 1920 1080 Progressive 50, 59.94

DNxHD 720p 100 Yes Yes 960 720 Progressive 25, 29.97, 50

DNxHD 720 90X-110X-220X Yes Yes 1280 720 Progressive 25, 29.97, 50

DNxHD 720 90-110-220 Yes Yes 1280 720 Progressive 25, 29.97, 50

DNxHD 720 60-75-145 Yes Yes 1280 720 Progressive 25, 29.97, 50

DNxHR 444
DNxHR HQX
DNxHR HQ
DNxHR SQ
DNxHR LB

Yes Yes 3840 2160 Progressive 23.976, 24, 
25, 29.97, 
50, 59.94

AVC-Intra 50 Yes Yes 1440 1080 Interlaced 59.94, 50

AVC-Intra 50 Yes Yes 960 720 Progressive 59.94, 50

AVC-Intra 100 Yes Yes 1920 1080 Interlaced 59.94, 50

AVC-Intra 100 Yes Yes 1280 720 Progressive 59.94, 50

XAVC-Intra 50 1080i Yes Yes 1440 1080 Interlaced 50, 59.94

XAVC-Intra 50 1080p Yes Yes 1440 1080 Progressive 23.976

XAVC-Intra 100 1080i Yes Yes 1920 1080 Interlaced 50, 59.94

XAVC-Intra 100 1080p Yes Yes 1920 1080 Progressive 23.976,

XDCAM HD EX 35Mbps VBR Yes No 1280 720 Progressive 59.94, 50

XDCAM HD Phase III 4:2:2 
50Mbps CBR

Yes No 1280 720 Progressive 59.94, 50

XDCAM HD Phase III 4:2:2 
50Mbps CBR

Yes No 1920 1080 Interlaced 59.94, 50

Generic_FTP_Profile - DHM Workflows

Format Ingest Playback W
H 
NTSC/PAL

Interlaced / 
Progressive

Frame 
Rate 
NTSC/PAL
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Avid has qualified the OP1A_EXPORT profile with the Omneon server and the 
OP1A_EXPORT_K2 Profile with the Grass Valley K2 server. These profiles may work with 
other devices that play and record Sony compliant media, but variations have been found and 
these are the only servers that we can guarantee will work. Deviations from the Sony XDCAM 
HD specification may result in clips not being recognized as the correct format, longer splicing 
and encoding times on export, or failure to work.

The following table lists the K2 media server playback formats available when setting up an FTP 
Server profile using Server Type: OP1A_EXPORT_K2. For information about working with a 
K2 server, see the document Working with a Thompson Grass Valley K2 Media Server.

OP1A_Export - DET Workflows to Omneon and Other FTP Servers

Format Ingest Playback W H
Interlaced / 
Progressive

Frame 
Rate 
NTSC/PAL

Profile 
and Level

XDCAM HD Phase 
III 4:2:2 50Mbps CBR

No Yes 1920 1080 Interlaced 59.94, 50 422@HL

XDCAM HD Phase 
III 4:2:2 50Mbps CBR

No Yes 1280 720 Progressive 59.94, 50 422@HL

XDCAM HD EX 
4:2:0 35Mbps VBR

No Yes 1280 720 Progressive 59.94, 50 MP@ML

OP1A_Export_K2 - DET Workflows to Grass Valley K2

Format Ingest Playback W H
Interlaced / 
Progressive

Frame 
Rate 
NTSC/PAL

Profile 
and Level

XDCAM HD Phase III 
4:2:2 50Mbps CBR

Yes Yes 1920 1080 Interlaced 59.94, 50 422@HL

XDCAM HD Phase III 
4:2:2 50Mbps CBR

Yes Yes 1280 720 Progressive 59.94, 50 422@HL

XDCAM HD EX 
4:2:0 35Mbps VBR

Yes Yes 1280 720 Progressive 59.94, 50 MP@ML
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Supported Formats for Sony XDCAM Profile - used only with Sony XDCAM Decks

Format Ingest Playback W
H 
NTSC/PAL

Interlaced / 
Progressive

Frame Rate 
NTSC/PAL

DV 25 Yes Yes 720 480/576 Interlaced 29.97, 25

DV 50 Yes Yes 720 480/576 Interlaced 29.97, 25

IMX 30 Yes Yes 720 486/576 Interlaced 29.97, 25

IMX 40 Yes Yes 720 486/576 Interlaced 29.97, 25

IMX 50 Yes Yes 720 486/576 Interlaced 29.97, 25

HD 1080i 17.5 Mbps Yes No 1440 1080 Interlaced 59.94, 50

HD 1080i 25 Mbps Yes No 1440 1080 Interlaced 59.94, 50

HD 1080i 35 Mbps Yes No 1440 1080 Interlaced 59.94, 50

HD 1080p 17.5 Mbpsa

a. Half height clips (1440x540) are not supported for 1080p formats.

Yes No 1440 1080 Progressive 23.976

HD 1080p 25 Mbpsa Yes No 1440 1080 Progressive 23.976

HD 1080p 35 Mbpsa Yes No 1440 1080 Progressive 23.976

XDCAM HD Phase III
4:2:2 50Mbps CBR

Yes No 1920 1080 Interlaced 59.94, 50

XDCAM HD Phase III 
4:2:2 50Mbps CBR

Yes No 1280 720 Progressive 59.94, 50



2 Interplay | Transfer Installation

The following sections are included in this chapter:

• Installation and Configuration Check List

• Turning On the Interplay | Transfer Engine Server

• Installing Avid Shared Storage Client Software

• Understanding the Software Required for Performing Transfers

• Installing the Interplay | Transfer Engine in a Workgroup Environment

• Installing Interplay | Transfer Engine Support Software

• Installing the Interplay | Transfer Engine Software in a Standalone Environment

Installation and Configuration Check List

The following sections provide check lists for setting up an Interplay Transfer Engine server and 
installing the Interplay Transfer Engine support software in a workgroup environment. There is 
also a check list for setting up Interplay Transfer in a standalone environment.

• Check List for Installing and Configuring an Interplay | Transfer Engine Server

• Check List for Installing and Configuring an Interplay | Transfer Engine in a Standalone 
Environment

• Check List for Installing Interplay | Transfer Engine Support Software
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Check List for Installing and Configuring an Interplay | Transfer Engine 
Server

The following table provides a check list of steps for installing and configuring the Interplay 
Transfer Engine server in an Avid shared storage workgroup and includes pointers to information 
about each step. The check list also covers installing and configuring the Interplay Transfer 
Engine client software on an Avid editing system.

Task Section Reference

 Check your configuration. See “Supported Interplay | Transfer 
Configurations” on page 9.

 Review network considerations. See “Networking Considerations” on page 12.

 Connect the Interplay Transfer server hardware 
and cables.

In a workgroup, the Interplay Transfer server is an 
Avid shared storage client. Depending on your 
Avid shared storage environment, see the 
following documents:

For Avid ISIS, see the Avid ISIS client setup 
documentation.

 Install cards in the Interplay Transfer server. See “Installing Cards in the Interplay Transfer 
Server” in the Interplay Production Software 
Installation and Configuration Guide.

 (Avid ISIS environment) Make sure the System 
Director software is installed and is running.

See the Avid ISIS administrator documentation.

 Start the Interplay Transfer server. See “Turning On the Interplay | Transfer Engine 
Server” on page 23.

 Install the Avid ISIS client software. See “Installing Avid Shared Storage Client 
Software” on page 24.

 Make sure the Interplay Production server has a user 
account for the Interplay Transfer server. 

The two accounts match exactly on the Interplay 
Transfer engine and Interplay Engine.

 Connect the Interplay Transfer application key. See the Interplay Production Software Installation 
and Configuration Guide.

 Install the Avid Service Framework for Client 
software.

See the Interplay Production Software Installation 
and Configuration Guide.

 Install the Interplay Access software. See the Interplay Production Software Installation 
and Configuration Guide.
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Check List for Installing and Configuring an Interplay | Transfer Engine in 
a Standalone Environment

The following table provides a check list of steps for installing and configuring the Interplay 
Transfer Engine software in a standalone environment and references where to find more 
information about each step. Note that a standalone environment can include shared storage but 
it does not include an Interplay Engine.

n Do not install Avid Service Framework on a standalone Avid editing system. The Service 
Framework is only required in an Interplay Production environment.

 Install the Interplay Transfer Engine. See “Installing the Interplay | Transfer Engine 
Software” on page 27.

 Set up the Interplay Transfer Engine Configuration 
tool.

See “Opening the Avid Interplay | Transfer 
Engine Configuration Tool” on page 36.

 Register the Interplay Transfer Engine in the 
workgroup.

See “Configuring an Interplay | Production 
Workgroup For Transfers” on page 49.

Avid Editing System

 Install the Interplay Transfer client software on Avid 
editing systems.

See “Installing the Interplay | Transfer Engine 
Client Software” on page 29.

 Configure the Transfer settings in the Avid editing 
application.

See “Configuring the Avid Editing Application 
for Transfers” on page 69.

Task Section Reference

Task Section Reference

 Check your configuration. See “Supported Interplay | Transfer Configurations” 
on page 9.

 Connect the Interplay Transfer 
application key.

See the Interplay Production Software Installation 
and Configuration Guide.

 Install the Interplay Transfer Engine 
software on Avid editing systems.

See “Installing the Interplay | Transfer Engine 
Software in a Standalone Environment” on page 31.

 Install the Interplay Transfer client 
software on Avid editing systems.

See “Installing the Interplay Transfer Engine Client 
Software in a Standalone Environment” on page 34.
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Check List for Installing Interplay | Transfer Engine Support Software

Depending on your workgroup configuration and the type of transfers performed in your 
workflow, you might need to install additional support software to transfer Avid assets or 
monitor transfers. The following table lists the support software and references where to find 
more information about installing the software.

Turning On the Interplay | Transfer Engine Server
To prepare your environment before you turn on the Interplay Transfer server:

1. Connect the Interplay Transfer Engine server hardware and cables. 

See the Avid shared storage client setup documentation.

2. Make sure your Avid shared storage environment is installed and running.Make sure the 
ISIS System Director is installed and running.

To start your Interplay Transfer Engine server:

1. Turn on all the peripherals connected to the Interplay Transfer Engine server. 

Make sure their power lights are on.

2. Press the Power button on the Interplay Transfer Engine server. 

The MEDIASwitch port lights turn on as the Interplay Transfer Engine server becomes 
ready.

 Setup the Interplay Transfer Engine 
Configuration tool.

See “Opening the Avid Interplay | Transfer Engine 
Configuration Tool” on page 36.

 Configure the Transfer settings in the 
Avid editing application.

See “Configuring the Avid Editing Application for 
Transfers” on page 69.

Task Section Reference

Task Section Reference

 Install the Interplay Production Services 
and Transfer Status software.

See “Installing the Interplay | Production Services and 
Transfer Status Tool” on page 30.

 Install the AutoTransfer Service See “Installing the Interplay |  Auto Media Services 
Service” on page 29.

 Install the Transfer Cache Engine 
software.

See “Installing the Transfer Cache Engine” on page 31.
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Installing Avid Shared Storage Client Software
After the Interplay Transfer Engine server starts properly, and before you install the Interplay 
Transfer Engine, you must install the Avid shared storage client software. 

In an Avid shared storage environment, the Interplay Transfer Engine server is an ISIS client. 

Throughout this document the term Avid shared storage client refers to Avid ISIS client.

To install the Avid ISIS client software: 

t See the Avid ISIS Client Quick Start Card.

Understanding the Software Required for Performing 
Transfers

To perform transfers, you need to install specific software components on the various servers and 
systems. The software you install and where you install it depends on your workgroup 
environment. The following table outlines where the software components are installed to 
perform transfers. You should use this table as a guide, depending on your workgroup 
environment.

The following sections provide procedures for installing the software components on the 
Interplay Transfer Engine server and Avid editing system. For detailed steps on installing 
Interplay Engine and Avid Service Framework for Server, see the Interplay | Production 
Software Installation and Configuration Guide.

Software

Installed on 
Interplay 
Production 
Server

Installed on 
Interplay Transfer 
Server

Installed on 
Avid Editing Client

Interplay Transfer Engine X

n To perform 
Generic FTP 
transfers you must 
install the 
Interplay Transfer 
Engine on the C 
partition of the 
Interplay Transfer 
server.

X

n Install only if in a 
standalone 
environment (not 
an Avid shared 
storage 
environment).
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n After installing the latest version of Interplay Transfer Engine, if you decide to reinstall an older 
version, make sure you uninstall the latest version before reinstalling the older version. When 
uninstalling the latest version, you should use Add or Remove Programs in the Control Panel and 
restart your computer after the uninstall is complete.

Understanding the Workgroup Environment Software

In a workgroup environment, after your hardware is properly set up, perform the following 
software installation procedures on the Interplay Transfer Engine server:

• Install the Avid Service Framework for Client software. See the Interplay | Production 
Software Installation and Configuration Guide.

• Install the Interplay Access software. See the Interplay | Production Software Installation 
and Configuration Guide.

• Install the Interplay Transfer Engine software. See “Installing the Interplay | Transfer Engine 
in a Workgroup Environment” on page 26.

Interplay Transfer Client X

Interplay Engine X

Interplay Access X X X

Interplay Auto Transfer (option)

n You can install the 
Interplay Auto Transfer 
service on any system in 
the workgroup.

Avid Service Framework for 
Client

X X

Avid ISIS Client

n The shared storage client 
software you install 
depends on your Avid 
shared storage 
environment.

X X X

Software

Installed on 
Interplay 
Production 
Server

Installed on 
Interplay Transfer 
Server

Installed on 
Avid Editing Client
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Install the following software on the various systems in the workgroup:

• Install the Interplay Transfer Engine Client software on the Avid editing systems. See 
“Installing the Interplay | Transfer Engine Client Software” on page 29.

• (Option) Install the Interplay Production Services and Transfer Status application on a 
standalone system. See “Installing the Interplay | Production Services and Transfer Status 
Tool” on page 30.

• (Option) Install the Interplay AutoTransfer service software on any system. See “Installing 
the Interplay |  Auto Media Services Service” on page 29.

Understanding the Standalone Transfer Environment Software

In a standalone transfer environment, for workstation-to-workstation transfers in an environment 
other than Avid shared storage, you must install the Interplay Transfer Engine software and the 
Interplay Transfer Engine client software on each client. For installation procedures, see 
“Installing the Interplay | Transfer Engine Software in a Standalone Environment” on page 31.

n In a standalone transfer environment, media files are tracked using Persistent Media Record 
(PMR) files. The Interplay | Media Indexer is not used to manage the media files.

Installing the Interplay | Transfer Engine in a 
Workgroup Environment

After you install the Avid shared storage client software on your Interplay Transfer Engine 
server, you can install the Interplay Transfer Engine software. Then you need to install the 
Interplay Transfer Engine client software on each client in the workgroup. The following 
sections provide procedures for installing the Interplay Transfer Engine software.

c Avid reminds you that data networks, such as standard data networks that support 
Internet Protocols, are not necessarily secure networks, and that any transfer of 
information over such networks  — whether internally or externally — is not necessarily a 
secure transfer. As when you communicate any information over any network, you are 
responsible for ensuring that you use network settings or implement policies that meet your 
security needs. Like other applications designed for use over a data network, the Interplay 
Transfer Engine application provides the capability for making transfers over a network 
but does not provide security for such transfers over unsecured networks. Avid makes no 
representations that transfers using Interplay Transfer Engine will be secure. Avid 
recommends that, before using Interplay Transfer Engine to transfer Avid assets over a 
network, you first evaluate your own security needs and implement appropriate measures 
to accommodate those needs, such as building any requisite firewalls and obtaining 
security certificates, or any other measures that you deem necessary to protect media being 
transferred over any network.
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n While Avid systems include password protection, such passwords are provided solely for your 
convenience to protect access to the Avid systems themselves and do not affect the security of 
information transferred over an unsecured data network.

Installing the Interplay | Transfer Engine Software 

In a workgroup environment, you need to install the Interplay Transfer Engine on the Interplay 
Transfer Engine server system. This software also installs the Interplay Transfer Engine 
Configuration software, which lets you set up the particular configuration for your Interplay 
Transfer Engine server. For descriptions of the Interplay Transfer Engine Configuration options, 
see “Interplay | Transfer Engine Configuration Settings” on page 36.

n If a previous release of Interplay Transfer Engine is installed on the computer, you should 
remove it before installing the new version of the software.

To install the Interplay Transfer Engine software:

1. Before you install the Interplay Transfer Engine, you need to connect the Interplay Transfer 
Engine USB application key (also called a dongle). 

2. Select the following from the Interplay Production Server Installer Main Menu:

Servers > Interplay Transfer Engine

The Install Interplay Transfer Engine page opens.

3. Make sure the following components are installed on the Interplay Transfer Engine server:

- Avid Service Framework for Client

- Interplay Access

For installation procedures, see the Interplay | Production Software Installation and 
Configuration Guide.

4. Click Interplay Transfer Engine and follow the steps in the InstallShield Wizard.
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5. In the Custom Setup dialog box, select how you want the Transfer FTP Services feature 
installed, if at all.

If your workgroup configuration includes supported ingest or playback of FTP devices, you 
should install the Transfer FTP Services.

6. Click Next to continue with the InstallShield Wizard.

7. (Option) In the InstallShield Wizard Completed dialog box, select Launch Interplay Transfer 
Engine Configuration tool, if you want to open the tool.

n To open the Interplay Transfer Engine Configuration tool after the Interplay Transfer Engine 
installation is complete, click the Start button, and select All Programs > 
Avid > Interplay Transfer Engine Configuration.

8. Click Finish.

9. If you selected Launch Interplay Transfer Engine tool, the Interplay Transfer Engine 
Configuration tool opens. Set the appropriate options in the Interplay Transfer Engine 
Configuration tool.

See “Interplay | Transfer Engine Configuration Settings” on page 36.

10. Click Yes to restart the server.
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Installing the Interplay | Transfer Engine Client Software

You must install the Interplay Transfer Engine client software on each client in the workgroup 
that plans on transferring Avid assets to another workgroup or playback device. However, Avid 
Instinct® and Interplay Assist have their own Interplay Transfer software, so you don’t need to 
install the Interplay Transfer client software on systems running Avid Instinct or Assist.

n If a previous release of Interplay Transfer Engine client is installed on the computer you should 
remove it before installing this version of the software.

To install the Interplay Transfer Engine client software on an Avid editing system:

1. Select the following from the Interplay Production Client Installer Main Menu:

Clients > Avid Editor Support

The Install Avid Editor Support page opens.

2. Click Interplay Transfer Engine Client.

3. Follow the installation instructions.

4. Repeat the installation for each client.

For information on configuring the Avid editing system for transfers, see “Configuring the Avid 
Editing Application for Transfers” on page 69.

Installing Interplay | Transfer Engine Support 
Software

Depending on your workflow and workgroup environment, you might need to install one of the 
Interplay Transfer Engine support software products. The following sections provide procedures 
for installing these software products

• Installing the Interplay |  Auto Media Services Service

• Installing the Interplay | Production Services and Transfer Status Tool

• Installing the Transfer Cache Engine

Installing the Interplay |  Auto Media Services Service

If your workflow requires auto transferring of assets, you need to install the Interplay Auto 
Media Services service that includes the AutoTransfer service. Installation of the Interplay Auto 
Media Services service is included with the Interplay Auto Archive installation. You can install 
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the Interplay Auto Media Services service on any system in the workgroup. However, it is 
usually installed on the system with the Interplay Production Services Engine. The Interplay 
Auto Transfer service automatically runs in the background.

To install the Interplay Auto Media Services service:

1. Select the following from the Interplay Production Server Installer Main Menu:

Servers > Interplay Production Services > Install Local Workflow Support > Interplay Auto 
Media Services

2. Follow the installation instructions.

AutoTransfer service is included with the Interplay Auto Media Services installation.

After you install the Interplay AutoTransfer service, see the following:

- For information about configuration settings for the AutoTransfer service, see 
“Configuring the Interplay | Auto Transfer Service” on page 112.

- For information on automatically transferring assets, see “Automatically Transferring 
Assets to Another Workgroup” on page 121.

Installing the Interplay | Production Services and Transfer Status Tool

The Interplay Production Services and Transfer Status tool lets you monitor transfers from a 
standalone system on your network. The Interplay Production Services and Transfer Status 
configuration settings apply only to the standalone system. These settings do not effect other 
components in a workgroup.

To install Interplay Production Services and Transfer Status software on a standalone 
system:

1. Select the following from the Interplay Production Server Installer Main Menu:

Servers > Interplay Production Services > Install Local Workflow Support > Interplay 
Production Services and Transfer Status

2. Follow the installation instructions.

For procedures on configuring the Interplay Production Services and Transfer Status tool, see 
“Configuring a Standalone System to Monitor Transfer Status” on page 65.
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Installing the Transfer Cache Engine

You can install the Interplay Transfer Cache Engine on a system without installing the Interplay 
Transfer Engine. The Transfer Cache Engine lets you monitor transfers in the workgroup.

The Interplay Transfer Cache engine automatically runs in the background. For procedures on 
monitor transfers, see “Configuring an Interplay | Production Workgroup For Transfers” on 
page 49.

n The Transfer Status window retrieves transaction status from the cache engine instead of the 
Interplay Transfer Engine.

To install the Transfer Cache Engine:

1. Select the following from the Interplay Production Server Installer Main Menu:

Servers > Interplay Transfer Engine > Interplay Transfer Cache

2. Follow the installation instructions.

Installing the Interplay | Transfer Engine Software in 
a Standalone Environment

If you are installing Interplay Transfer Engine for workstation-to-workstation transfers in an 
environment other than Avid shared storage, you must install the Interplay Transfer Engine 
software and Interplay Transfer Engine client software on each client.

The Interplay Transfer Engine software also installs the Interplay Transfer Engine configuration 
software, which lets you set up the particular configuration for your workstation transfers.

n Workstation-to-workstation transfers are not supported with Avid Instinct systems.

A hardware application key (also known as a dongle) is not required when installing the 
Interplay Transfer Engine in a standalone environment. The Avid editing software handles the 
licensing of the Interplay Transfer Engine.

For procedures on installing the Interplay Transfer Engine standalone software:

• Installing the Interplay | Transfer Engine on a Standalone Editing System

• Installing the Interplay Transfer Engine Client Software in a Standalone Environment
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Installing the Interplay | Transfer Engine on a Standalone Editing System

To install the Interplay Transfer Engine on an Avid editing system:

1. Insert the Interplay Transfer application media and double-click autorun.exe.

The Interplay Transfer installer opens.

2. Click Interplay Transfer Engine and follow the steps in the InstallShield Wizard.
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3. In the Custom Setup dialog box, select how you want the Transfer FTP Services feature 
installed, if at all.

If your environment configuration includes supported ingest or playback FTP devices, you 
should install the Transfer FTP Services.

n In a standalone editor plus AirSpeed workflow, do not select the Transfer FTP Services option. 
This option causes transfers to fail as the Interplay Transfer tries to use an FTP profile instead of 
the correct AirSpeed DHM to handle the transfer.

4. Click Next to continue with the InstallShield Wizard.

5. In the InstallShield Wizard Completed dialog box, select Launch Interplay Transfer Engine 
tool, if you want to open the tool.

n To open the Interplay Transfer Engine Configuration tool after the Interplay Transfer Engine 
installation is complete, click the Start button, and select All Programs > 
Avid > Interplay Transfer Engine Configuration.

6. Click Finish.
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7. If you selected Launch Interplay Transfer Engine tool, the Interplay Transfer Engine 
Configuration tool opens. Set the appropriate options in the Interplay Transfer Engine 
Configuration tool.

See “Interplay | Transfer Engine Configuration Settings” on page 36.

8. Click Yes to restart the server.

Installing the Interplay Transfer Engine Client Software in a 
Standalone Environment

You must install the Interplay Transfer Engine client software on each standalone client.

To install Interplay Transfer Engine client software in a standalone environment:

1. Insert the Interplay Transfer application media and double-click the autorun.exe file.

The Interplay Transfer installer opens.

2. Click Interplay Transfer Engine Client.

3. Follow the installation instructions.



3 Interplay | Transfer Configuration

This chapter describes how to configure the Interplay Transfer Engine system and Interplay 
Transfer Engine clients after you install the software. This chapter describes both an Interplay 
workgroup environment and a standalone Interplay Transfer configuration. The Interplay 
Transfer Engine server is a Avid shared storage client.

• Opening the Avid Interplay | Transfer Engine Configuration Tool

• Interplay | Transfer Engine Configuration Settings

• Setting the Number of Simultaneous Transfers Allowed by the Interplay | Transfer Engine

• Configuring Workgroup Transfer Presets

• Configuring an Interplay | Production Workgroup For Transfers

• Configuring a Remote Workgroup for Workgroup-to-Workgroup Transfers

• Specifying Interplay | Transfer Engines for Direct Transfers

• Configuring a Standalone System to Monitor Transfer Status

• Configuring Interplay | Transfer Engine in a Standalone Environment

• Configuring the Avid Editing Application for Transfers

• Configuring Capture and Playback of MXF DHM OPIa File Formats

• Configuration for Playing Back to a Sony XDCAM SD Device

• Configuration for Working with XDCAM HD and XDCAM EX Assets

• Configuring a Thunder Production Server

• Configuring Ingest From FTP Deck Devices

• Configuring an Ingest Device Catalog

• Configuring a Playback Device Catalog

• Configuring the Interplay | Auto Transfer Service
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Opening the Avid Interplay | Transfer Engine 
Configuration Tool

To open the Interplay Transfer Engine Configuration tool:

t In a workgroup environment, from the Interplay Transfer Engine server, click the Start 
button, and select All Programs > Avid > Avid Interplay Transfer Engine Configuration.

t In a standalone environment, from an Avid editing system, click the Start button, and select 
All Programs > Avid > Interplay Transfer Engine Configuration.

Interplay | Transfer Engine Configuration Settings
The Interplay Transfer Engine Configuration tool lets you set several options for performing 
various types of media transfers. 

n The Interplay Transfer Engine Configuration tool does not display options that are deselected. 
Also, when setting values for the various options, if you deselect an option the values for that 
area return to their default value.
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To open the Interplay Transfer Engine Configuration tool, see “Opening the Avid 
Interplay | Transfer Engine Configuration Tool” on page 36.
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For information about the options in the Interplay Transfer Engine Configuration tool, see the 
following table. For changes to take effect, you must restart the Interplay Transfer Engine server 
or, in a standalone environment, restart the Avid editing system.

Interplay Transfer Engine Configuration Settings 

Option Description

Workgroup Settings

Interplay enable In a workgroup environment, select this option to enable the Interplay 
Engine. When this option is selected the Standalone settings are ignored.

Interplay Engine hostname In a workgroup environment, type the computer name for the Interplay 
Production Server associated with the workgroup this Interplay Transfer is 
attached to.

User name and Password In a workgroup environment, type the user name and password that the 
Interplay Transfer should use to connect to the Interplay Production Server. 
This user account must already exist on the Interplay Engine. 

Accept incoming 
workgroup transfers without 
Interplay Production login

In a workgroup environment, select this option if you want to accept 
incoming workgroup transfers even if the Interplay Transfer is not logged in 
to Interplay Engine.

No-login workspace for 
incoming transfers

In a workgroup environment type the name of the Avid shared storage 
workspace where you want the incoming transfers to be sent. This 
workspace must already exist and you must have access to it. If you are 
performing captures, you must set this to an Avid shared storage 
workspace.

Standalone Settings n The Standalone settings are ignored when the Interplay Production 
enable option is set in the Workgroup Settings area.

Accept incoming transfer 
after timeout

In a standalone environment, select this option if you want to accept 
incoming transfers after the set timeout. When you are performing 
standalone transfer operations between clients, the timeout value must be 
set to less than 15 seconds. Avid recommends a timeout value of 
10 seconds.

OMF
AAF

In a standalone environment, select either OMF or AAF depending on for 
the type of media files being transferred. 
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Directory for incoming 
transfers

In a standalone environment, type the name of the directory where you want 
Interplay Transfer to place the incoming transfers. This directory must be a 
valid media files directory. Click Browse to locate a valid directory. 

The default directories are:

In OMF mode - OMFI MediaFiles

In AAF mode - Avid MediaFiles\MXF\1 

n For better performance when media files grow beyond 10,000 files in 
the primary directory \1, you need to change the Directory for 
incoming transfers to Avid MediaFiles\MXF\2.

System Settings

Enable auto-cleanup of 
transfer queues

Transfer queues are not automatically deleted from the server system. The 
queues let you see the history of the transfers. Select this option if you want 
the transfer queues cleaned up on a regular basis. The default is to 
Auto-cleanup transfers that are older than 360 minutes (6 hours) and to run 
the auto-cleanup every 12 minutes. 

Logging

Server logging off
Standard logging on
Debug logging on

These three options are used for troubleshooting problems. If errors 
occurred where Avid Customer Support needs more information from log 
files, you might have to change these settings. The default is Standard 
logging on.

Storage

Storage Type In a workgroup environment, select the type of storage (for example, ISIS 
v2.x) used in the workgroup to increase the performance of transfers. See 
“Increasing the Performance of Workgroup-to-Workgroup Transfers” on 
page 161. 

Buffer size The system selects a buffer size depending on your storage type. If your 
system has 2GB or less RAM it will only allow an 8MB buffer size. See 
“Increasing the Performance of Workgroup-to-Workgroup Transfers” on 
page 161.

Configure FTP Servers If during the install process, you selected “Interplay Transfer Server with 
Supplement FTP Services” in the “Choose the installation type that best 
suits your needs” dialog box, you need to configure the FTP server 
parameters. See “Configuring Capture and Playback of MXF DHM OPIa 
File Formats” on page 74. All entries must match the device’s setup.

Interplay Transfer Engine Configuration Settings 

Option Description
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Workgroups

Workgroup transfers 
enabled

In a workgroup environment, select this option to enable 
workgroup-to-workgroup transfers.

In a standalone environment, select this option to enable transfers to another 
workstation.

Incoming workgroup 
transfers enabled

In a workgroup environment, select this option to enable transfers from 
another workgroup. The maximum number of incoming transfers is set to 8. 
This value is doubled in the calculation for Total Transfers (All Types).

In a standalone environment, select this option to enable transfers from 
another workstation.

Max. outgoing transfers You can specify the maximum number of simultaneous outgoing 
workgroup transfers. Values range is 1-4. This value is included in the 
calculation for Total Transfers (All Types).

See “Setting the Number of Simultaneous Transfers Allowed by the 
Interplay | Transfer Engine” on page 45.

Directory for temporary 
composition files

Type the directory name where you want temporary files to be placed 
during the capture process or during incoming workgroup transfers. The 
default directory is C:\temp.

Delete temporary 
composition files after 
transfer

Select this option during normal use. Avid Customer Support might ask you 
to deselect this option when you are troubleshooting problems.

Interplay Transfer Engine Configuration Settings 

Option Description
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Workgroup names Sets the name of remote workgroups and their Interplay Transfer server. 

n This setting is ignored when performing workgroup transfers from 
within Interplay Access. The available destination workgroups are 
set using the “Configure Remote Workgroups” site setting in the 
Interplay Production Administrator. 

Do the following: 

1. Click Add.

2. In the Workgroup Name text box, type a nickname for the remote 
workgroup. This name can be any name you decide to use for the 
remote workgroup. The name you enter for the workgroup appears in 
the Transfer menu on the Avid editing application.

3. In the Maps to Server Name text box, type the computer name of the 
Interplay Transfer server of the remote workgroup.

Playback

Playback transfers enabled Enables playback transfers. Select this option if your workgroup includes a 
playback device such as an Omneon.

Max. simultaneous 
playback transfers

Sets the maximum number of simultaneous playback transfers. (Value 
range is 0-20, however the device determines the transfer limit. See the 
device documentation for the number of supported transfers.) This value is 
included in the calculation for Total Transfers (All Types).

See “Setting the Number of Simultaneous Transfers Allowed by the 
Interplay | Transfer Engine” on page 45.

Interplay Transfer Engine Configuration Settings 

Option Description
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Playback devices Enter the name or names of any playback devices in your workgroup. 

n You do not need to list AirSpeed or AirSpeed Multi Stream systems 
here, because these systems have their own Interplay Transfer 
software and configuration settings. 

n When creating an FTP Server profile with the Server Type set to 
OP1A_Export or OP1A_Export_K2 for playback of OP1A formats, it 
is not necessary to add the server and profile name to the Playback 
Devices list. The profile name is listed automatically in the Send to 
Playback list on the Avid editing systems.

For the following devices, do the following:

• For Grass Valley™ Group Profile® systems, type the computer name of 
the playback device. 

• For Generic FTP playback devices, see “Configuring a Generic FTP 
Playback Device into a Workgroup” on page 82.

(Option) In a workgroup environment, when adding a playback device you 
can associate an Interplay Access Catalog with the playback device, select 
Enter Playback Catalog Name, and type a name for the playback catalog. 
See “Configuring a Playback Device Catalog” on page 111.

(Option) When using ancillary data “D” tracks in your Avid editing 
application, you can filter out the D track before sending to a DHM MXF 
encoder. By default, D tracks are not sent to DHM MXF encoders. See 
“Filtering Ancillary Data During Send to Playback” on page 83.

Stating at Interplay v3.0, tape ID names can be modified by the Transfer 
Engine before issuing the Send To Playback Request. In the case of Generic 
FTP Send To Playback, this will result in the renaming of the asset to the 
new format when writing out to the FTP server. See “Creating Transfer 
Engine Tape IDs for STP Transfers” on page 85.

Ingest

Ingest transfers enabled Enables ingest transfers. Select this option if your workgroup includes an 
ingest device. 

Max. simultaneous ingest 
transfers

Sets the maximum number of simultaneous ingest transfers. (Value range is 
0-20, however the device determines the transfer limit. See the device 
documentation for the number of supported transfers.) This value is 
doubled in the calculation for Total Transfers (All Types).

See “Setting the Number of Simultaneous Transfers Allowed by the 
Interplay | Transfer Engine” on page 45.

Interplay Transfer Engine Configuration Settings 

Option Description



Interplay | Transfer Engine Configuration Settings

43

Ingest devices Type the name or names of any ingest devices in your workgroup. 

n You do not need to list AirSpeed or AirSpeed Multi Stream devices 
here, because these devices have their own Interplay Transfer 
software and configuration settings.

For the following devices, do the following:

• For a Generic FTP ingest device, see “Configuring a Generic FTP 
Ingest Device into a Workgroup” on page 90.

• For adding a FTP ingest device, type the name associated with the 
ingest device. See “Adding FTP Ingest Devices into an 
Interplay | Transfer Engine Configuration” on page 105.

• (Option) In a workgroup environment, select Enable Auto Scavenge if 
your workgroup includes an Avid Media Browse system and Interplay 
Production Services and ProEncode, and you want to create a 
low-resolution copy of ingested clips on the Media Browse system. 
During ingest, high-resolution files are created on Avid shared storage. 
In the text box, type the name of the scavenge process created on the 
Media Browse. See the Media Browse documentation.

• (Option) In a workgroup environment, when adding an ingest device 
you can associate an Interplay Access Catalog with the ingest device. 
Select Enter Ingest Catalog Name and type a name for the ingest 
catalog. See “Configuring an Ingest Device Catalog” on page 109.

Dynamically Extensible 
Transfers (DET)

DET enabled Enables DET transfers.

Max. DET push transfers Sets the maximum number of simultaneous DET push transfers; Avid 
recommends.

Max. DET pull transfers Sets the maximum number of simultaneous DET pull transfers; Avid 
recommends.

Interplay Transfer Engine Configuration Settings 

Option Description
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Total Transfers
(All Types)

Max. simultaneous transfers Sets the maximum number of simultaneous transfers.

By default, the value in this text box is the recommended maximum number 
of total simultaneous transfers for your workgroup environment. This value 
is updated when you change one of the values used during the calculation or 
when you click the Calculate button. You can change the recommended 
value in the text box, however, the value you enter must meet the limitations 
of your workgroup environment. For more information about this option, 
see “Setting the Number of Simultaneous Transfers Allowed by the 
Interplay | Transfer Engine” on page 45.

n The higher the number of simultaneous transfers, the more the 
impact on performance.

Playlist Information

Use Newsroom rundowns to 
schedule transfers

Enables the Interplay Transfer Newsroom rundown scheduling feature. See 
“Working with Rundowns” on page 125.

Newsroom Server Type the computer name of the Newsroom Server.

User Name Type the user name that Interplay Transfer should use to connect to the 
Newsroom Server.

Password Type the password Interplay Transfer should use to connect to the 
Newsroom Server.

Schedule File Name Type the file name of the schedule file that Interplay Transfer should use to 
determine which rundown to use at which time. See “Working with 
Rundowns” on page 125.

Interplay Transfer Engine Configuration Settings 

Option Description
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Setting the Number of Simultaneous Transfers 
Allowed by the Interplay | Transfer Engine

The Interplay Transfer Engine Configuration tool has several options that set the maximum 
number of simultaneous transfers for the various types of transfers. This section explains these 
options and how they relate to each other.

The number set in the Max. simultaneous transfers text box located in the Total Transfers (All 
Types) area determines the maximum number of total simultaneous transfers allowed by the 
Interplay Transfer Engine. By default, the value in this text box is the recommended maximum 
number of total simultaneous transfers for your workgroup environment. This value is updated 
when you change one of the values used during the calculation or when you click the Calculate 
button. You can change the recommended value in the text box, however, the value you enter 
must meet the limitations of your workgroup environment.

n The number set in the Max. simultaneous transfers text box located in the Total Transfers (All 
Types) area, becomes a hard limit for the maximum number of total simultaneous transfers 
allowed by the Interplay Transfer Engine.

The recommended number of maximum total simultaneous transfers is calculated using the 
values set for these options:

• Ingest area - Max. simultaneous ingest transfers value (value range is 0-20, however, the 
device sets the transfer limit. see the device documentation for the number of supported 
transfers.)

• Playback area - Max. simultaneous playback transfers value (value range is 0-20, however, 
the device sets the transfer limit. see the device documentation for the number of supported 
transfers.)

• Workgroups area - If the Incoming workgroup transfers enabled option is selected, then by 
default the Max. incoming transfers = 8 is used in the calculation.

• Workgroups area - Max. outgoing transfers value (value range is 1-4)

The values for ingest and incoming transfers are doubled when calculating the maximum number 
of total simultaneous transfers allowed. The values entered into the individual transfer text boxes 
represent the total number of actual transfers allowed for each of the functions. 

For example, a value of 4 in the ingest text box means that at any time the Interplay Transfer 
Engine permits a total of four ingest transfers to take place. Similarly, if playback transfers is set 
to 2 then only two playback transfers are allowed at the same time. However, because of the way 
incoming data is written to shared storage, an incoming transfer uses twice as much Interplay 
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Transfer Engine bandwidth as a playout transfer. This factor is taken into account when 
calculating the total number of simultaneous transfers that are currently configured. When using 
the example above (4 ingest and 2 playout) this equates to a total of 10 simultaneous transfers. 

Another example, if you want your Interplay Transfer Engine to perform a total of 5 
simultaneous transfers, and your workflow requires three ingest transfers at a specific time, and 
five Send to Playback transfers at another time of the day. 

You can set the values as follows:

• Max. simultaneous transfers text box to 6

• Max. simultaneous ingest transfers value to 3

• Max. simultaneous playback transfers value 5

Using these values limits the Interplay Transfer Engines output and lets the jobs queue and then 
run as the bandwidth allows. However, workgroup transfers cannot queue on the receiving 
Interplay Transfer Engine. If the receiving Interplay Transfer Engine is not setup to allocate 
enough bandwidth in the Max. simultaneous transfers setting, then the transfer fails. Setting the 
maximum number of incoming workgroup transfers to a fixed value of 8, lets four other 
workgroups simultaneously send to this Interplay Transfer Engine. If this value is too high you 
can change the Max. simultaneous transfers value.

Explanation of Options in the Workgroups Area

Option Selection Description

Workgroup transfers enabled Select or deselect When this option is selected the workgroup 
options are displayed and are available.

Incoming workgroup transfers 
enabled

Select or deselect When this option is selected the maximum 
number of incoming transfers is set to 8. This 
value is doubled in the calculation for Total 
Transfers (All Types).

Max. outgoing transfers Value range is 1 to 4 You can specify the maximum number of 
simultaneous outgoing transfers.
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The following illustration shows the options.

Configuring Workgroup Transfer Presets
When performing workgroup transfers, you can use presets to select a predefined destination for 
the transferring assets. Transfer presets define the remote workgroup, a destination workspace, 
and a destination folder for the metadata. You can also choose whether to display the preset name 
in the Send to Workgroup dialog box.

When setting up a workgroup transfer preset the available choices depend on the type of remote 
workgroup transfer. For example:

• If the remote workgroup is an Avid MediaManager, you might be able to select a workspace 
but cannot select a destination folder.

• If the transfer is a standalone Transfer Engine, you cannot select a workspace or a 
destination folder.
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To configure a transfer preset:

1. Click Start and select All Programs > Avid > Interplay Access Utilities > Interplay 
Production Administrator.

The Interplay Production Server Login dialog box opens.

2. Select an Interplay Production Server, type a username, and password.

3. Click Connect.

The Interplay Production Administrator opens.

4. In the Site Settings area, click Workgroup Transfer Presets.

The Workgroup Transfer Presets view opens.

5. Click Add below the Presets list.

Untitled displays in the Name text box.

6. Type a name for the preset in the Name text box.

Presets list Name text box
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7. Select the remote workgroup server from the Remote Workgroup menu.

The remote workgroup servers available from the Remote Workgroup menu are defined in 
the Configure Remote Workgroups view of the Interplay Production Administrator. For 
information on adding a remote workgroup to the Remote Workgroup menu, see 
“Configuring a Remote Workgroup for Workgroup-to-Workgroup Transfers” on page 57.

8. (Option) Select Workspace and select a destination workspace for the media files from the 
Workspace menu.

If you do not select a workspace, the default destination workspace is used.

9. (Option) Select Destination and select a destination folder in the remote workgroup database 
for the metadata.

If you do not select a folder, the default destination folder is used.

10. (Option) Select Enabled, if you want this preset to display in the Send to Workgroup dialog 
box.

11. Click Apply to save your changes.

Configuring an Interplay | Production Workgroup For 
Transfers

The Interplay Production Administrator provides Interplay Transfer Engine site settings for 
registering Interplay Transfer Engine engines, AirSpeed systems, and other Interplay Transfer 
Engine enabled devices in an workgroup. After an Interplay Transfer engine is registered, you 
can access it from any Interplay Transfer Engine client in the workgroup. The type of transfers a 
server or device can perform depends on the transfer settings.

The Interplay Transfer Engine Settings let you:

• Select a Transfer Cache engine for monitoring various Interplay Production transfers. You 
can choose which Interplay Transfer Engine engines and Interplay Transfer Engine enabled 
devices are monitored by a Transfer Cache engine. See “Selecting a Transfer Cache Engine 
for Monitoring Transfers” on page 52.

• Add an AirSpeed Studio that simultaneously distributes a Send to Playback request to 
multiple AirSpeeds. See “Adding an Avid AirSpeed Studio” on page 55.

• Configure a Studio to allow Send to Playback requests to individual AirSpeeds in the Studio.

• List the transfer devices in the various Send to menus.

• Set the length of time between refreshing the Transfer Status view. See “Setting the Refresh 
Time of the Interplay | Transfer Engine Status Window” on page 56.
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Opening the Interplay | Transfer Engine Settings View

To open the Interplay Transfer Engine Settings View:

1. Click Start and select All Programs > Avid > Interplay Access Utilities > Interplay 
Production Administrator.

The Interplay Engine Login dialog box opens.

2. Select an Interplay Production Server, type a username, and type a password.

3. Click Connect.

The Interplay Production Administrator opens.
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4. In the Site Settings area, click Interplay Transfer Engine Settings.

The Interplay Transfer Engine Settings view opens.

n The Transfer Cache engine listed in the Cache Hostname text box monitors all items listed in the 
Transfer Engines list. The Interplay Transfer Engine Status view displays all Transfer Engines 
listed in the Transfer Engine list.

n The Interplay Transfer Engines listed in the Interplay Transfer Engines list might appear in the 
various Send To commands, such as Send to Playback. The settings you choose determines which 
Interplay Transfer Engines appear in which command list.

List of 
Transfer
Cache 
Engines

List of Transfer Engines
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Selecting a Transfer Cache Engine for Monitoring Transfers

The Transfer Cache engine you select to monitor transfers can be located on an Interplay 
Transfer Engine server or on a separate server (a server other than the servers performing the 
transfers). A typical configuration for monitoring transfers uses the Transfer Cache engine 
located on the Interplay Transfer Engine server. 

When monitoring transfers, you might want to select a Transfer Cache engine on a separate 
server to improve transfer performance. Monitoring transfers can be resource intensive for a 
Transfer Cache engine and might impact transfer performance. Depending on the activity of your 
workgroup, the following actions can impact transfer performance:

• Performing a large number of transfers with the Interplay Transfer Engine

• Transferring a large amount of data with the Interplay Transfer Engine

• Monitoring several Interplay Transfer Engines through the Transfer Cache engine

• Monitoring several Interplay Transfer Engine enabled devices

• Connecting several status clients to the Transfer Cache engine

By default, to improve performance, the Transfer Cache engine only polls the status of transfers 
when a client requests status of an Interplay Transfer Engine.

A Transfer Cache engine installs automatically when you install the Interplay Transfer Engine. 
The Transfer Cache engine starts on the server when you start the Microsoft Windows operating 
system. Therefore, starting the Interplay Transfer Engine is not required to use the Transfer 
Cache engine. You can also install a Transfer Cache engine without installing the Interplay 
Transfer engine. For installation procedures, see “Installing the Transfer Cache Engine” on 
page 31.

n A Transfer Cache engine is not installed on AirSpeed devices. To monitor AirSpeed transfers, 
you must use a Transfer Cache engine located on a separate server.

To establish a Transfer Cache engine for monitoring transfers:

1. Open the Interplay Transfer Engine Settings view. 

See “Opening the Interplay | Transfer Engine Settings View” on page 50.

2. Below the Cache Engines list, click Add to add a new Transfer Cache engine to the list. 
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3. Change the default Transfer Cache engine name by doing the following:

a. In the Cache Hostname text box, type the hostname of the server you want to use for 
monitoring transfers.

b. Press Enter.

The default cache name is replaced with the hostname you typed in the Cache Hostname 
text box.

4. Create a list of the Interplay Transfer Engines and Studios that you want to monitor through 
the Transfer Cache engine.

t To add Interplay Transfer Engines, see “Adding Interplay | Transfer Engines” on 
page 53.

t To add a Studio, see “Adding an Avid AirSpeed Studio” on page 55.

If the Transfer Cache engine is located on an Interplay Transfer Engine server, you must add 
the Transfer Cache engine’s hostname to the Transfer Engines list.

Adding Interplay | Transfer Engines

The Transfer Cache engine listed in the Cache Hostname text box monitors all transfers handled 
by the Interplay Transfer Engines listed in the Transfer Engines list. 
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You can add Interplay Transfer Engines, AirSpeed devices, or other Interplay Transfer 
Engine-enabled devices using the following procedure. For a procedure to add a Studio to the 
list, see “Adding an Avid AirSpeed Studio” on page 55.

To add an Interplay Transfer engine or Interplay Transfer Engine enabled device to the 
Transfer Engines list:

1. Open the Interplay Transfer Engine Settings view. 

See “Opening the Interplay | Transfer Engine Settings View” on page 50.

2. Establish a Transfer Cache engine for monitoring transfers. 

See “Selecting a Transfer Cache Engine for Monitoring Transfers” on page 52.

3. In the Transfer Engines area of the Interplay Transfer Engine Settings view, click Add.

A default name displays in the Transfer Engines list.

4. In the Transfer Engine Details area, from the Type menu, select Transfer Engine or 
AirSpeed.

5. In the Hostname text box, change the default name by typing the hostname of the Interplay 
Transfer Engine server or Interplay Transfer Engine enabled device that you want to add. 

6. Press Enter.

In the Transfer Engines list, the default name is replaced with the hostname you typed in the 
Hostname text box.

7. From the Workgroup Transfers menu, select the type of workgroup transfers allowed by this 
server or device:

t For an Interplay Transfer Engine, select either Send Only, Receive Only, Send and 
Receive, or No.

For Interplay Transfer Engines, the Workgroup Transfers setting only effects workgroup 
transfers that are initiated from the Interplay Access or by dragging a Workgroup 4.5 asset 
into the Interplay Transfer Engine Status View. This setting has no effect on transfers 
initiated from Avid editing systems.

t For an Interplay Transfer Engine-enabled device, such as an AirSpeed, select No. 

Workgroup transfers are not allowed by these devices.

8. (Option) If you want an Interplay Transfer Engine to be the primary Interplay Transfer 
Engine used by the Avid editing systems, select “Primary Transfer Engine for Editors.”

Each workgroup can have only one primary Interplay Transfer Engine. When workgroup 
transfers are initiated from an Avid editing system the workgroup transfers are handled by 
the primary Interplay Transfer Engine. Only Interplay Transfer Engines installed on a 
Transfer server are allowed to be a primary transfer engine.

9. Click Apply when you finish adding all the Interplay Transfer Engines to the list.
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Adding an Avid AirSpeed Studio

An AirSpeed Studio is a group of AirSpeeds that simultaneously processes Send to Playback 
requests. In a workgroup, a Transfer Cache engine can monitor the transfers handled by the 
Studio members. When you add a Studio to a workgroup, you can choose whether to list the 
individual members of the Studio in the Send to Playback menu.

To add a Studio to the Transfer Engines list:

1. Open the Interplay Transfer Engine Settings view. 

See “Opening the Interplay | Transfer Engine Settings View” on page 50.

2. Establish a Transfer Cache engine for monitoring transfers. 

See “Selecting a Transfer Cache Engine for Monitoring Transfers” on page 52.

3. In the Transfer Engines area of the Interplay Transfer Engine Settings view, click Add.

A default name displays in the Transfer Engines list.

4. In the Transfer Engine Details area, from the Type menu, select Studio.

The default name is appended with [1] indicating it is a Studio.

n A Studio is identified using the following naming convention: studioname[N]

In this example, studioname is the Host Name assigned in the AirSpeed application, and N 
represents the number of members in the Studio.

For more information about naming and configuring the AirSpeed and Studio, see the AirSpeed 
documentation.

5. In the Studio Name text box, change the default name by typing the hostname of the Studio.

6. Click the Transfer Engines list.

The default name is replaced with the hostname you typed in the Studio Name text box.

7. In the Studio Host Count menu, select the number of members in the Studio.

The maximum number of Studio members is 8.
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8. Press Enter. 

The number you selected is appended to the Studio name. For example, if you select 3, the 
Studio name appears as Studioname[3].

9. (Option) If you want each Studio member to display in the Send to Playback menu, select 
“Show individual studio hosts in the Send To Playback choices.”

10. Click Apply when you finish adding all the Studios to the Transfer Engines list.

Setting the Refresh Time of the Interplay | Transfer Engine Status 
Window

You can adjust the amount of time between refreshes of the Interplay Transfer Engine Status 
window.

n This setting does not impact how frequently the Transfer Cache engine polls the Interplay 
Engine.
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To set the Interplay Transfer Engine Status view refresh time:

1. Open the Interplay Transfer Engine Settings view. 

See “Opening the Interplay | Transfer Engine Settings View” on page 50.

2. In the Refresh Interval (ms) text box, type the amount of time you want between refreshes of 
the status view. The unit is millisecond (ms).

3. Click Apply.

Configuring a Remote Workgroup for 
Workgroup-to-Workgroup Transfers

A large site can include more than one workgroup. When a workflow requires searching across 
remote workgroups or performing workgroup-to-workgroup transfers through Interplay Access, 
an administrator must set up the local workgroup so that a user can access a remote workgroup. 
You set up this access in the Interplay Production Administrator tool’s Configure Remote 
Workgroup view. The administrator of the remote Workgroup also needs to add the user name 
and password of the local workgroup to allow login.

n Configuring a remote workgroup in this view is not needed for transfer from Interplay Assist, 
Avid Instinct, or Avid editing systems.

After access to a workgroup is properly configured, an Interplay Access user can select from a 
list of remote workgroups when performing a search or a transfer. For example, databases for 
properly configured remote workgroups are listed in the Server list of the Workgroup Transfer 
Presets view and in the Interplay Access Send to Workgroup dialog box.

n You can configure a maximum of 10 hostnames. For example, you can configure for searching 
five remote workgroups and five Nearchive servers for a total of 10.

To set up access to remote workgroups:

1. Make sure the list of users for the remote workgroup includes the user name and password of 
users in the local workgroup who require access to the remote workgroup. For transfers, 
make sure the user name and password match exactly, and that Administrator passwords also 
match exactly.

2. In the Site Settings section of the Interplay Production Administrator window, click 
Configure Remote Workgroups icon.
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3. In the Configure Remote Workgroups view, select a database from the Available Databases 
list on the left.

4. In the New server pane, add information about the remote workgroup that you want to 
access.

a. Select the Host Type:

- Interplay Production Server/Remote Search, to add access to a remote Interplay 
workgroup.

- TransferManager, to add access to a Workgroup 4 TransferManager.

- MediaManager, to add access to a Workgroup 4 workgroup or Avid Nearchive 
system.

- Interplay Production Server/3rd Party Search, to add access for a third-party 
plug-in. The plug-in needs to be properly installed before you can configure it. See 
“Using Third-Party Search Plug-ins” in the Interplay | Access User’s Guide.

b. Type information for the remote workgroup in the Nickname field. 

The fields vary, depending on the Host Type you selected. For the Server, you can type 
the remote workgroup’s IP address instead of the host name. The Nickname must be less 
than 255 characters.

c. Click Add.

The Server name and other information about the remote workgroup appears in the list 
of accessible remote servers.

Available database list List of accessible remote workgroup servers and 
transfer servers

Settings for adding remote 
Workgroup servers and 
TransferManager servers
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To remove a remote workgroup from the accessible list:

1. Click the name of the remote workgroup in the list.

2. Click Remove.

Specifying Interplay | Transfer Engines for Direct 
Transfers

You can specify the local and remote Interplay Transfer Engines used during a 
workgroup-to-workgroup transfer of Avid assets. This is referred to as a “direct transfer.” 

The direct transfer feature is useful if you need to identify specific hosts that should perform 
transfers. It is a way to reserve specific transfer engines for certain operations, thus ensuring 
faster transfers. For example, you can specify a transfer engine in your broadcast facility that 
only transfers media to a remote site covering a specific sporting event.

When creating a direct transfer preset, there are several combinations of Transfer Engines that 
you can specify for the transfers:

• Let any available local Transfer Engine handle the transfer and specify the remote Transfer 
Engine.

• Specify a local Transfer Engine to handle the transfer and let any available remote Transfer 
Engine receive the transfer. 

• Specify a local Transfer Engine to handle the transfer and specify a remote Transfer Engine. 

• Specify a list of local Transfer Engines to handle the transfer and let any available remote 
Transfer Engine receive the transfer.

Checklist for Direct Transfer

Use the following checklist to help you configure and perform a direct transfer.

Task Section Reference

 Add the local Transfer Engines to the local 
workgroup.

“Configuring a Workgroup for Direct Transfer” on 
page 60

 Add the remote workgroup and Transfer 
Engines to the local workgroup.

“Configuring a Workgroup for Direct Transfer” on 
page 60

 Create a Workgroup Transfer Preset. “Creating a Transfer Preset” on page 62

 Perform the direct transfer. “Performing a Direct Transfer” on page 63
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c As soon as the first Workgroup Transfer Preset that uses the new options for “Local 
Transfer Engine” or “Remote Transfer Engine” is stored in the database, an Access V3.0.5 
or earlier client will not be able to parse any Workgroup Transfer Presets. After you select 
“Send to Workgroup,” a “Malformed serialized string” message is displayed and the Send 
To Workgroup dialog will not be displayed.

Previously Published Method for Direct Transfer

A procedure for direct transfer was documented in the Avid Interplay Transfer Setup and User’s 
Guide prior to release of Interplay Access v2.7.7. Interplay Access v2.7.7 and later continues to 
support this method and improves it through several fixed bugs. Note that the new procedure 
introduced in Interplay Access V2.7.7 does not rely on a specifically named preset and is easier 
to configure and use.

Configuring a Workgroup for Direct Transfer

Before you can perform a direct transfer, you need to configure the workgroup for local Interplay 
Transfer Engines and remote Transfer Engines.

To configure a workgroup for direct transfers:

1. Add the local Transfer Engines to the workgroup.

a. In the Interplay Administrator, click Interplay Transfer Settings in the Site Settings area.

The Interplay Transfer Settings view opens.

b. Configure the Interplay Transfer Settings as you would for adding Transfer Engines in a 
workgroup. See “Configuring an Interplay | Production Workgroup For Transfers” on 
page 49.

In the Transfer Engine Details area, select one of the following from the Workgroup 
Transfers menu:

- No: (Recommended) Removes the Transfer Engine from the pool of available 
Transfer Engines and enables it to be used exclusively for direct transfers.

- Send and Receive: Specifies that the Transfer Engine can be used for both send and 
receive operations. Keeps the Transfer Engine in the pool of available Transfer 
Engines, but also keeps it available for direct transfers. 
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- Send Only: Specifies that the Transfer Engine can only be used for send operations. 
Keeps the Transfer Engine in the pool of available Transfer Engines, but also keeps 
it available for direct transfers.

2. In the local workgroup, register remote workgroups and remote Transfer Engines, using the 
Interplay Administrator > Site Settings > Configure Remote Workgroups view. The 
following illustration shows an example.

For information about the Configure Remote Workgroups view, see “Configuring a Remote 
Workgroup for Workgroup-to-Workgroup Transfers” in the Avid Interplay Transfer Setup 
and User’s Guide.
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n The Server name you enter in the Configure Remote Workgroups view appears in the Access 
Send to Workgroup dialog box. The Nickname field is not used for Direct Transfer.

Creating a Transfer Preset

Use the Interplay Administrator to create one or more transfer presets specifically for the direct 
transfers.

To configure a transfer preset for direct transfer:

1. In the Site Settings area, click Workgroup Transfer Presets.

The Workgroup Transfer Presets view opens.

2. Click Add below the Presets list.

Untitled displays in the Name text box.
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3. Type a name for the preset in the Name text box.

Type a descriptive name for the preset. This name will be displayed in the Send to 
Workgroup dialog box.

4. Select the remote workgroup server from the Remote Workgroup menu.

The remote workgroup servers available from the Remote Workgroup menu are defined in 
the Configure Remote Workgroups view in the Interplay Administrator.

To enable the option of selecting a remote Transfer Engine (step 6), you must select an 
Interplay Engine server. If you do not need to use this option, you can select a Transfer 
Engine server.

5. (Option) Select the local Transfer Engine from the Local Transfer Engine menu.

Select a local Transfer Engine if you want to use only the selected Transfer Engine for this 
preset. If you do not select a specific Transfer Engine, any available Transfer Engine defined 
in the Interplay Transfer Settings view will be used.

6. (Option) Select the remote Transfer Engine from the Remote Transfer Engine menu.

Select a remote Transfer Engine if you want to use only the selected Transfer Engine for this 
preset. If you do not select a specific Transfer Engine, any available Transfer Engine defined 
in the Configure Remote Workgroups view will be used.

This option is displayed only if you select an Interplay Engine server from the Remote 
Workgroup menu (step 4). 

7. (Option) Select Workspace and select a destination workspace for the media files from the 
Workspace menu.

If you do not select a workspace, the default destination workspace is used.

8. (Option) Select Destination and select a destination folder in the remote workgroup database 
for the metadata.

If you do not select a folder, the default destination folder is used.

9. Select Enabled to display this preset in the Send to Workgroup dialog box.

10. Click Apply to save your changes.

Performing a Direct Transfer

To perform a direct transfer from one workgroup to another workgroup:

1. Start Interplay Access by logging into your local workgroup.

2. Make sure your workgroup is configured for direct transfers as described in the previous 
topic.

3. From the Content view, right-click on the Avid asset that you want to transfer.
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4. Select Send to Workgroup.

The Send to Workgroup dialog box opens.

5. From the Destination preset menu, select the preset that you want to use for the direct 
transfer. 

The preset automatically selects the Destination folder and Workspace.

6. Click OK.

- If the selected preset includes a destination folder and a direct Remote Transfer Engine, 
or if the Remote Workgroup server is a Transfer Engine, you do not need to wait for the 
destination folder and workspace to be displayed before you click OK.

- If the selected preset does not include a destination or a Remote Transfer Engine, you 
must select a destination and then click OK (selecting a workspace is optional). If you 
receive an error that states “Please select a destination,” wait until the destination folder 
and workspace are displayed, select your destination, and click OK again.

The transfer begins or is placed in the list waiting for transfer.

If you selected Launch Interplay Transfer Status window on the Send to Workgroup dialog 
box, then the status window opens and displays the status of the transfer.
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Configuring a Standalone System to Monitor 
Transfer Status

The Interplay Production Services and Transfer Status tool lets you monitor transfers and 
services of various workgroups and servers from a standalone system on the network. After you 
install the application on a standalone system, you need to configure the Media Services and 
Transfer Status settings.

n For installation procedures, see “Installing the Interplay | Production Services and Transfer 
Status Tool” on page 30.

Any changes you make to the configuration settings apply only to the standalone system. They 
do not affect other components in a workgroup.

To configure a standalone system for monitoring transfers:

1. Click Start and select All Programs > Avid > Interplay Production Services and Transfer 
Status.

The Interplay Production Services and Transfer Status tool opens.

2. Click the Transfer tab.
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3. Click Configure Workgroups.

The Configure Workgroups dialog box opens.

4. To add a workgroup you want to monitor, do the following:

a. Click + below the Workgroups list.

b. Change the default workgroup name by typing the name of the workgroup you want to 
monitor in the Workgroup Name text box.

c. Press Enter.

The default name is replaced with the workgroup name you typed. 

The workgroups displayed in the Workgroups list appear in the Workgroup menu on the 
Transfer tab of the Interplay Production Services and Transfer Status tool.

Add a 
Workgroup

Workgroups 
list
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5. Set the various settings to select a cache host and add Interplay Transfer Engine Engines and 
Interplay Transfer Engine enabled devices to the monitoring list. 

These settings are similar to the settings in the Interplay Transfer Engine Settings view, 
except that the Primary Transfer Engine and the Refresh Interval options are not available. 
For procedures that explain these settings, see “Selecting a Transfer Cache Engine for 
Monitoring Transfers” on page 52.

6. Click Save.

Monitoring Transfer Status from a Standalone System

To monitor transfers from a standalone system on your network:

1. Click Start and select All Programs > Avid > Interplay Production Services and Transfer 
Status.

The Interplay Production Services and Transfer Status tool opens.

2. Click the Transfer tab.

3. From the Workgroup menu, select the workgroup you want to monitor.
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4. Click Connect.

The status view opens.

For descriptions of the status components, see “Understanding the Interplay | Transfer 
Engine Status Window” on page 153.

Configuring Interplay | Transfer Engine in a 
Standalone Environment

When you are installing Interplay Transfer Engine for workstation-to-workstation transfers in an 
environment other than an Interplay workgroup environment, you must install the Interplay 
Transfer Engine and Interplay Transfer Engine client software on each client. For information on 
installing the Interplay Transfer Engine software in standalone environments, see “Installing the 
Interplay | Transfer Engine Software in a Standalone Environment” on page 31.

n The Avid Instinct and Interplay Assist products are available only in a workgroup environment, 
therefore, you cannot add them in a standalone environment. These products have their own 
Interplay Transfer software.
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The Interplay Transfer Engine software installs the Interplay Transfer Engine configuration 
software that lets you set up the particular configuration for transfers from your Avid editing 
system. For descriptions of the various settings on the Interplay Transfer Engine Configuration 
window, see “Interplay | Transfer Engine Configuration Settings” on page 36.

Configuring the Avid Editing Application for 
Transfers

After you install the Interplay Transfer Engine client software on an Avid editing system, you 
can configure the transfer process.

For procedures on configuring the Avid editing application for transfers, see the following 
topics:

• Setting Transfer Settings in the Avid Editing Application

• Multi-Channel Mapping for Send to Playback

• Allowing Transfers to Other Workgroups and Workstations

Setting Transfer Settings in the Avid Editing Application

To activate Interplay Transfer Engine each time you start your Avid editing application and 
to have the application notify you of incoming transfers:

1. In the Avid editing application, click the Settings tab in the Project window.

2. Double-click Transfer in the Settings list.

The Transfer Settings dialog box opens.
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3. Click the Settings tab.

4. In the Standalone/Incoming Requests area, do one of the following:

t Select “Refuse All Requests,” if you do not want to receive files from another 
workgroup. 

t Select “User Dialog To Accept/Refuse,” and one of the following methods for accepting 
transfers:

Wait for User Action (No Timeout) — You receive a message request for a transfer. You 
must click OK for the transfer to occur.

Accept After Timeout — The system automatically accepts the file after the timeout.

Refuse After Timeout — The system does not accept the file after the timeout.
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In the Timeout (seconds) text box, type the amount of time you want to set for the 
timeout.

5. In the Status Window area, do the following:

a. In the text box, type the number of seconds you want the status window to update.

b. (Option) Select “Bring up window if error occurs” if you want errors to display.

6. (Option) In a workgroup environment, if you want mixed-resolution items highlighted in the 
bin, select “Highlight mixed-resolution items” in the Send to Playback area.

If a sequence contains DV 25 and DV 50 media within the same sequence, that sequence is 
highlighted in red in the bin. Interplay Transfer Engine cannot send sequences that contain 
both DV 25 and DV 50 media to playback. This feature allows you to easily identify those 
sequences.

7. In the Output Audio Mix area, select the type of audio output you want.

t Direct channel output - Send to Playback transfers audio tracks without performing a 
mixdown.

t Stereo output - Send to Playback mixes all of the tracks to a stereo pair, using pan 
controls to split the tracks. The sequence is copied before the mixdown is edited in, and 
the suffix .transfer is added to the name (same as in the direct output option).

8. In the Transcode area, if you want to allow the transcoding of clips before performing a send 
to playback operation, do the following:

t Select “Transcode before sending to playback.”

t From the Minimum resolution warning threshold menu, select the lowest resolution 
allowed for the playback device before a warning message is displayed.

For example, if you select MPEG30, a warning message will display during a send to 
playback operation, if a clip in the sequence has a resolution below MPEG30. Therefore, no 
warning message displays when clip resolutions are MPEG30 and above.

n Dynamic Relink must be enabled to use the Transcode before sending to playback option.

For more information about using these settings, see “Transcoding of Mixed Resolution 
Clips During a Send to Playback” on page 127.

9. Click OK.

Multi-Channel Mapping for Send to Playback

Interplay Transfer supports ingest and playout of 16 tracks of audio for the following servers:

• Thompson Grass Valley K2 Media Server

• Omneon
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The following limitations apply

• IMX30/40/50 resolutions - up to 8 Audio tracks allowed

• MSS - up to 8 Audio tracks allowed

• Avid AirSpeed Multi Stream - up to 8 Audio tracks allowed

• Avid AirSpeed - up to 8 Audio tracks allowed

• Sony XDCAM - up to 8 Audio tracks for IMX30/50 allowed, up to 4 Audio Tracks for 
DVCAM allowed

Using the Transfer Settings dialog box, you can map any combination of audio tracks to any of 
the 16 available output channels when you send a sequence to playback using Interplay Transfer. 
The Send To Playback operation performs a mixdown on the selected tracks before the 
application sends the sequence to Interplay Transfer. For additional information see “Mapping 
Audio Tracks to Output Channels” in the What’s New for Media Composer v5.5 or the Help for 
you Avid editing system.

Best Practices for using Direct Out mode

This section describes a best practice for sending a sequence containing multi-channel (also 
known as multichannel) audio tracks to playback when using Direct Out mode.

When using Direct Out mode, keep the multi-channel audio tracks at the bottom of your audio 
tracks. When you send to playback in Direct Out mode the system expands the stereo tracks to 
separate mono tracks. If there are single tracks at the bottom of the track list you may get 
unexpected results after the top tracks expand. For example, a single track that was on track 5 
may now be on a different track. If you keep the single tracks at the top you can avoid this kind 
of problem. See the editing application Help for additional information on multi-channel audio.

Allowing Transfers to Other Workgroups and Workstations

Depending on your environment, you can transfer items to other workgroups and workstations 
that have Interplay Transfer Engine software installed.

n Avid AirSpeed and Avid AirSpeed Multi Stream are considered workgroups.

To allow transfers to other workgroups and workstations:

1. In the Avid editing application, click the Settings tab in the Project window.

2. Double-click Transfer in the Settings list.

The Transfer Settings dialog box opens.
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3. Click the TMClient.ini tab.

4. Do one of the following:

t In a workgroup environment, type the Interplay Transfer Engine server computer name 
in the Server text box, and type the name of your workgroup in the Workgroup text box. 
This name must exactly match the workgroup named used in the Avid Service 
Framework. To view the name, open the Workgroup Properties tool from the Start 
menu.

t In a standalone environment, type the computer name of the local system (this 
computer) in the Server text box, and in the Workgroup text box, type the name you 
want to see in the Transfer menu.

c These fields are case-sensitive.

5. In the Other Workgroups area, click Add. 

The Add Workgroup To List dialog box opens.

If you want to edit the names of any of the Interplay Transfer Engine servers or workstations 
listed in the Other Workgroups area, select the name, click Edit, and make the changes.
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6. Do one of the following:

t In a workgroup environment, type the name of the other Interplay Transfer Engine 
server in the Server text box, and type the name of the your workgroup in the 
Workgroup text box.

t In a standalone environment, in the Server text box, type the computer name of other 
workstation, and in the Workgroup text box, type the name you want to see in the 
Transfer menu.

7. Click OK.

The name you typed displays in the Other Workgroups list.

Configuring Capture and Playback of MXF DHM OPIa 
File Formats

To enable interoperability between Interplay Production and third-party devices that use the 
MXF OP1a file format, Avid has developed an optional Interplay Transfer Engine Data Handling 
Module (DHM) plug-in that supports FTP integration to third-party MXF OP1a compliant 
devices. The Interplay Transfer Engine MXF OP1a FTP DHM allows MXF OP1a files to be 
brought into Avid shared storage or an Avid editing environment from an FTP server. You can 
also export Avid media files in MXF OP1a format to an FTP server using this same MXF OP1a 
FTP DHM.

Depending on the type of FTP server you are configuring, you might need to perform some 
specific procedures:

• Thunder production server; see “Configuring a Thunder Production Server” on page 104

• Avid Omneon server; see “Configuration for Working with an Omneon Server” on page 100

• Thomson Grass Valley K2 Media Server; see the document Working with the Thomson 
Grass Valley K2 Media Server.

You must do the following to integrate a FTP server into a workgroup:

• Select “Interplay Transfer Engine Server with Supplemental FTP Services” as the 
installation type when installing the Interplay Transfer Engine application. See “Installing 
the Interplay | Transfer Engine in a Workgroup Environment” on page 26.

n After the installation, you can verify the FTP DHM is installed by using the Dongle Dumper. To 
open the Dongle Dumper, navigate to C:\Program Files\Avid\Utilities\Dongle Dumper.

• Configure the FTP parameters for the FTP server. See “Configuring an FTP Server Profile” 
on page 75.
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• Configure an FTP playback device using the Interplay Transfer Engine Configuration dialog 
box. See “Configuring a Generic FTP Playback Device into a Workgroup” on page 82.

• Configure an FTP ingest device using the Interplay Transfer Engine Configuration dialog 
box. See “Configuring a Generic FTP Ingest Device into a Workgroup” on page 90.

• Create an FTP directory profile. See “Creating and Editing FTP Directory Profiles on 
Interplay | Transfer Client” on page 90.

For FTP transfer procedures, see “Transferring To and From Generic FTP Servers” on page 130.

Configuring an FTP Server Profile

When adding an FTP server to your workgroup environment, you need to create an FTP server 
profile for the server’s FTP parameters. Depending on the type of FTP server, the settings will 
vary.

n After you create a profile of the FTP parameters for the FTP server, you cannot edit the Profile 
Name, Default Directory, or FTP Mode settings. If you need to change these settings, you need to 
create a new profile for the FTP server.

To create a profile for the FTP server’s configuration in a workgroup:

1. On your Interplay Transfer Engine server, click the Start button, and select All Programs > 
Avid > Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration dialog box opens.

2. Click the Configure FTP Servers button.

The FTP Configuration dialog box opens.
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If the Configure FTP Servers button is not available, “Interplay Transfer Engine with 
Supplemental FTP Services” was not selected as the installation type when the Interplay 
Transfer Engine application was installed. You need to reinstall the Interplay Transfer 
Engine software.

3. Click Add.

The FTP Server dialog box opens.
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4. Enter the setup information for the FTP server you are configuring.

See “FTP Server Dialog Box Settings Used to Create an FTP Server Profile” on page 77.

5. Click OK.

6. On the FTP Configuration dialog box, type the port number in the Generic FTP Port text 
box. 

Avid recommends using 6534. This is a local host server listener set up internally by 
Interplay Transfer.

7. Click Done.

FTP Server Dialog Box Settings Used to Create an FTP Server Profile

Depending on the type of FTP server you are adding to your workgroup, the settings you enter 
will vary. For specific server settings, see the following sections:

• Avid Thunder server, see “Configuring a Thunder Production Server” on page 104.

• Omneon server, see “Creating an FTP Server Profile for an Omneon Server” on page 100.

• Thomson Grass Valley K2 Media Server; see the document Working with the Thomson 
Grass Valley K2 Media Server.

For a procedure on creating a FTP Server profile, see “Configuring an FTP Server Profile” on 
page 75.

FTP Server configuration 

Setting Description

Profile Name Type a name for this profile. 

n The name you assign to the profile appears in the FTP Media 
Browser application and Send to Playback list.

Host Name Type the name of the FTP server.

Username Type the user name used to connect to the FTP server.

Password Type the password used to connect to the FTP server.
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Setting an Aspect Ratio For Send To Playback

When performing a Send To Playback operation with MXF OP1a files, the desired video aspect 
ratio might not display. You can set a playback aspect ratio for Send To Playback transfers when 
you create an FTP Server profile for server type GENERIC_FTP_PROFILE.

During the ingest or import process of media, the aspect ratio might not be preserved as expected 
in an Avid shared storage environment. For example, 16:9 media might be stored as 4:3. Also, 
the essence might be altered to the 4:3 SD format during the ingest or import process. Typically, 
a playback MXF OP1a aspect ratio metadata should be in sync with its essence. Any difference 
between the aspect ratio value in the essence and its MXF metadata wrapper might cause an 
MXF compliance error. Depending on the MXF decoder, these differences might have different 
behaviors. 

Server Type Select the type of server in the workgroup: 
GENERIC_FTP_PROFILE, OMNEON_SERVER_PROFILE, 
D10_PROFILE, SONY_XDCAM_PROFILE, OP1A_Export.

n When creating an FTP Server profile with the Server Type set 
to OP1A_Export for playback of OP1A formats, it is not 
necessary to add the server and profile name to the Playback 
Devices list. The profile name is listed automatically in the 
Send to Playback list on the Avid editing systems.

Playback Format (Playback only) Select a playback format from the menu. This option 
only applies when Server Type is set to GENERIC_FTP_PROFILE, 
SONY_XDCAM_PROFILE, and OP1A_Export. 

Image Aspect Ratio This option applies when Server Type is set to 
GENERIC_FTP_PROFILE. For information about this setting, see 
“Setting an Aspect Ratio For Send To Playback” on page 78.

FTP Connection Information

Default Directory Displays the directory on the FTP server where data is sent to or 
retrieved from. Type a period (.) in the field to point to the home 
directory of the user that is configured on the FTP server.

FTP Mode Displays the FTP mode as active.

Port Type the FTP connection port. The default is 21.

FTP Server configuration 

Setting Description
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By default, the aspect ratio displayed during a Send To Playback operation is the modified aspect 
ratio metadata value stored in the Avid shared storage environment. When setting up an FTP 
Server profile, you can overwrite the aspect ratio metadata value using the Playback Aspect 
Ratio option. This option is only available when Server Type is set to 
GENERIC_FTP_PROFILE. 

c Before using the Playback Aspect Ratio option there are several points to consider. This 
aspect ratio overwrite at Send To Playback, does not change the essence in anyway, or set 
the essence’s aspect ratio bits, if there are any. You might have MXF compliance issues with 
respect to MXF aspect ratio metadata. The Playback Aspect Ratio option sets the aspect 
ratio metadata in the playback MXF OP1A file without checking the essence. You should 
evaluate the MXF playback file to make sure it displays the correct aspect ratio at target 
display devices.

Playback Aspect Ration Options

Option Name Playback MXF Ratio Value

Default Aspect ratio is unchanged. No overwrite of the Avid shared storage 
file.

Unspecified SMPTE Rational type value 0:0

This is the SMPTE Distinguished value for Aspect Ratio. MXF 
decoders have to parse the essence or use some means to determine 
the aspect ratio to use when displaying the video at target display 
devices.

4:3 SMPTE Rational type value 4:3

16:9 SMPTE Rational type value 16:9
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For information on setting up a FTP Server profile, see “Configuring an FTP Server Profile” on 
page 75.

Configuring OP1A/XDCAM Profiles for Catalog Checkins

Interplay | Transfer v3.1 allows you to configure OP1A/XDCAM profiles for catalog checkins.

To configure OP1A/XDCAM Profiles for Catalog Checkins:

1. Create an OP1A FTP profile in the FTP Server dialog box, as shown in the following 
illustration. The profile name FTP1 refers to the FTP server with the hostname CET-FTP.
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2. In the Playback Device dialog box, create a new playback device that references the OP1A 
FTP server device configured in the FTP Server dialog box.

a. Specify the Profile Name. This is the name that will appear in the editor as a playback 
target.

b. Specify the Device Name. This is the profile name of the OP1A FTP device configured 
in the FTP Server dialog box.

c. Leave the Service Host and Service Port fields blank.

d. Select Enable Playback Catalog Name and specify the Catalog name.

e. Click OK.

n (UDevC00184240) The first time you click OK, the Enable Playback Catalog Name option 
becomes unchecked. Workaround: Select the Enable Playback catalog Name option again and 
click OK.

3. Select the newly created Playback Device, not the original OP1A_EXPORT profile, as your 
playback target in the editor.

Note the following:

- The catalog checkin simply updates an asset in Interplay Access that has been 
previously checked in to Access by the editing application or by STP Encode. This 
feature relies on the XDCAM sequence having already been checked in to Access and 
will not work if it has not.

- A single OP1A device can be used to configure multiple Playback Devices with 
different catalog names.
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Configuring a Generic FTP Playback Device into a Workgroup

When adding a Generic FTP playback device into your workgroup environment, you need to 
configure the device using the Interplay Transfer Engine Configuration dialog box.

Starting at Interplay v2.6 you can define an alias name for the playback device. The alias name 
appears in the Avid editing application when you select Transfer > Send to Playback.

n In the Interplay Transfer Engine Configuration tool, when creating an FTP Server profile with 
the Server Type set to OP1A_Export or OP1A_Export_K2 for playback of OP1A formats, it is 
not necessary to add the server and profile name to the Playback Devices list. The profile name is 
listed automatically in the Send to Playback list on the Avid editing systems.

To add a generic FTP playback device into a workgroup:

1. On your Interplay Transfer Engine, click the Start button, and select All Programs > Avid > 
Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration dialog box opens.

2. In the Playback area, click Add.

The Playback Device dialog box opens. 
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3. Define the Generic FTP playback device as follows:

- Profile Name is the alias that you want to use for the device. The alias appears in the 
Avid editing application user interface when you select Transfer > Send to Playback.

If you leave the field blank, the system creates a name based on the device name and 
service host name that you enter.

- Device Name is the name of the playback device.

- Service Host is the Interplay Transfer server name.

- Service Port is the Generic FTP port address for the playback device.

The port number used for the playback device must match the Generic FTP Port number 
on the FTP Configuration dialog box. See “Configuring an FTP Server Profile” on 
page 75.

4. (Option) You can assign a playback catalog for transfers. The Catalog field appears when 
you click Enable Playback Catalog Name. See “Configuring a Playback Device Catalog” on 
page 111.

5. Click OK.

6. Click Save.

Filtering Ancillary Data During Send to Playback

A number of new MXF playback encoders and playback devices can process or consume D 
tracks with ancillary data. However, the following limitations must be taken into account:

• Legacy playback DHM Op1A MXF encoders may not be coded properly to handle any 
extraneous ancillary data track (“D tracks”) made available in Interplay 2.2.

• Even if existing or new MXF encoders are able to process D tracks, the destination playback 
devices may not be able to consume D tracks.

• Even if both the encoder and playback device can process the material, there will be times 
when the ancillary data is not required and should be ignored.

Given the above considerations, Interplay Transfer allows you to filter out any D tracks via the 
Transfer Manager configuration utility. D track filtering is on by default.

n See the Interplay Production ReadMe for details on support for ingest and playback of Long 
GOP material containing ancillary data.



Configuring Capture and Playback of MXF DHM OPIa File Formats

84

To enable or disable D track filtering:

1. Open the Interplay Transfer Configuration dialog box.

2. Configure a new playback device as usual or click the Edit button in the Playback devices 
list to edit an existing playback device.

The Playback Device dialog box opens.

Allow Ancillary Data 
Tracks checkbox
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3. Enable or disable the checkbox as required and click OK. 

The checkbox is unchecked by default. This means that the playback of D tracks is turned 
off by default for existing legacy playback devices.

How Interplay | Transfer Turns Off Ancillary Data Tracks for Playback

When the “Allow Ancillary Data tracks” option is disabled via Transfer Manager configuration 
utility, the D tracks filtering mechanism takes affect as follow:

• Any D tracks present are not read and populated into its playback frame queues.

• Any playlist or sub clip playlist returned by the playback composition sequence will omit 
any D tracks even if they present.

As the result, any DHM MXF encoders will not “see” any D tracks and do not need to handle 
them. In this way, existing MXF encoders should continue to encode only video and audio tracks 
correctly and transparently.

The above filtering mechanism does not apply to any DET-based transfers.

Creating Transfer Engine Tape IDs for STP Transfers

A new setting has been added to the Transfer Engine “Playback Device” configuration, which 
allows tape ID names to be modified by the Transfer Engine before issuing the Send To Playback 
Request. In the case of Generic FTP Send To Playback, this will result in the renaming of the 
asset to the new format when writing out to the FTP server.

c Changing the tape ID in this way affects the naming of the asset on the target server. If you 
already have a successful workflow using Tape IDs, this method may not be useful.
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Configuring the TapeID

To configure a tape ID:

1. Open the Interplay Transfer Engine Configuration tool.

2. Select a playback device in the Playback area (bottom center).

3. Click the Edit button.

The Playback Device dialog box opens.

4. Type a string in the Tape ID field as follows: 

a. Select a tag from the Add menu. For additional information, see “Using the TapeID 
Format String” on page 87.

b. Add any additional text before or after the tags you select. Text that is not contained 
between angle brackets will be added to the tape ID name.

n The illustration above shows an example string. The field is blank by default. To clear the string, 
delete the text and click OK.

5. Click OK.
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Using the TapeID Format String

The following table shows the values that you can supply as tags.

Tape ID Examples

The following examples show how to use the Tape ID format string.

Clip created on the Media Composer with tape ID Bruins001

Tape ID Format String: <PLAYOUTID>-<MOBID>

Resultant Tape ID on the Playback device:

Bruins001-060a2b340101010101010f0013-000000-4ea6b88b890a0547-060e2b347f7f-2a80.mx
f

Clip created on the Media Composer with tape ID Patriots001

Tape ID Format String: WG1-<PLAYOUTID>-<TRACKLIST>-<COMPRESSION>

Resultant Tape ID on the Playback device:

WG1-Patriots001-V1A1A2A3A4-Avid-MPEG2-30.mxf

Tag value Description

PLAYOUTID Sequence tape ID added by the editor during a send to 
playback operation

MOBID Sequence Mob ID

NAME Sequence name

TIMECODE Timecode value

DURATIONFRAMES Sequence duration expressed as number of frames

DURATIONTIMECODE Sequence duration expressed as HHMMSSFF (Hours, 
Minutes, Seconds, and Frames).

FPS Frames Per Second, expressed as 24, 25, or 30.

COMPRESSION Video format

TRACKLIST List of tracks in sequence in the format 
“V1D1A1A2A3A4”
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n If your workflow includes entering a Tape ID value when you perform a STP operation from the 
editor, you must include the PLAYOUTID tag. Or keep the text field blank.

Using Tape ID strings with OP1-a Generic FTP Profiles

You don’t typically open the Playback Device dialog box when creating Generic FTP profiles. If 
you want to use the Tape ID for a Generic FTP profile, do the following.

To configure a Tape ID name for a Generic FTP profile:

1. Open the Interplay Transfer Engine Configuration tool.

2. Select a playback device in the Playback area (bottom center).

3. Click the Edit button.

The Playback Device dialog box opens.

4. Leave the following fields blank as shown in the above illustration:

- Profile Name

- Service Host

- Service port

5. Enter the profile name in the Device Name field.

6. Configure the Tape ID field as described earlier and click OK.
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Writing to a Temp File with Generic FTP profiles

The “Write to Temporary File” playback profile option causes OP1A media files to be written to 
a temporary file (.tmp extension) during the transfer. After the transfer is complete, the system 
renames the file with an .mxf extension. 

This is done to prevent automation systems from attempting to move the file while the file is still 
being transferred. The following illustration shows how this option is enabled through the 
Transfer Engine configuration tool.
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Configuring a Generic FTP Ingest Device into a Workgroup

When adding a Generic FTP ingest device into your workgroup environment, you need to 
configure the device using the Interplay Transfer Engine Configuration dialog box.

To add a Generic FTP ingest device into a workgroup:

1. On your Interplay Transfer Engine, click the Start button, and then select All Programs > 
Avid > Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration dialog box opens.

2. In the Ingest area, click Add.

The Device dialog box opens.

3. Type the name of the FTP profile that contains the information required to connect to a 
particular directory on a FTP server. 

See “Configuring an FTP Server Profile” on page 75.

When adding an ingest device, you do not need to type the host name of the Interplay 
Transfer Engine server or the port address of the ingest device. The FTP profile provides this 
information.

4. Click OK.

5. Click Save.

Creating and Editing FTP Directory Profiles on Interplay | Transfer Client

When a workgroup includes an FTP server, you need to create FTP directory profiles on the 
Interplay Transfer client that allows the FTP server to connect with the Avid editing system. The 
FTP Directory Profile must contain the same connection information as the Interplay Transfer 
Engine Configuration settings.
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The Avid FTP Media Browser application is used for ingest from FTP servers.

When working with Grass Valley K2 Media Server, see the document Working with the Thomson 
Grass Valley K2 Media Server.

To create and edit FTP directory profiles:

1. From the Avid editing system, click the Start button, and then select All Programs > Avid > 
Utilities > Avid FTP Media Browser.

The FTP Media Browser application opens.

Status bar Connect status
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2. Click Edit to open the FTP Source Window.

The FTP Source Window opens, providing a list of FTP directory profiles.
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3. Do one of the following:

t Click Add to add a new profile.

t Select a Profile Name and click Edit to edit an existing profile.

The Ftp Directory Profile Window opens.

4. Type the configuration information for the FTP server, making sure your entries match the 
FTP server’s network settings.

See “FTP Directory Profile Window Settings” on page 94.

5. (Option) Click Test Connection if you want to verify that the connection to the FTP 
directory is working.

6. Click Save.

For additional information about the FTP Media Browse window, see “Workflow: Capturing 
Clips From an FTP Server” on page 131.
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FTP Directory Profile Window Settings

The following table describes the settings used when creating or editing FTP Directory Profiles 
on an Interplay Transfer Client.

For a procedure on creating or editing an FTP Directory profile, see “Creating and Editing FTP 
Directory Profiles on Interplay | Transfer Client” on page 90.

Configuring the Interplay | Transfer Client For Direct Captures

Before you can use the Direct Capture method to capture media directly from FTP devices and 
FTP servers, you need to configure the Interplay Transfer client.

n For procedures on performing direct captures, see “Workflow: Capturing Clips From an FTP 
Server” on page 131 and “Capturing Clips From FTP Devices” on page 137.

Ftp Directory Profile Window Settings 

Setting Description

Profile Name Name of this profile. A unique profile name is used for each directory.

Port Displays the port number used by the FTP server (not the playback port).

FTP Hostname Type the FTP server’s network name. This FTP host name must match the 
server name assigned during the configuration of the FTP parameter. See 
“Configuring an FTP Server Profile” on page 75.

User Name Type your user name.

Password Type the FTP server’s password.

FTP Mode Displays the FTP mode as Passive or Active.

Server Type Select the type of server in the workgroup: GENERIC_FTP_PROFILE, 
OMNEON_SERVER_PROFILE, D10_PROFILE.

Directory Path Displays the default directory where the source media is located on the FTP 
server.

Force UTF-8 names 
from server

Select this option when using clips that contain non-English characters. Fixes a 
problem where clips containing non-English characters did not update correctly 
in the Media Services Transfer Status window.
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To configure an Interplay Transfer client for directly capturing media:

1. Click Configure Transfer Client on the FTPClipList dialog box or Avid - FTP Media 
Browser dialog box.

The TransferManager Client Configuration dialog box opens.

2. In the Workgroup Name text box, type the name of your workgroup. 

This name can be any name you have given your entire workgroup.

3. In the Host Name text box, type the computer name of the Interplay Transfer Engine.

4. (Option) If you have more than one Interplay Transfer Engine in your workgroup, you can 
enter them in this dialog box.

a. Click Add and type the computer name of the other Interplay Transfer Engine.

b. Click OK.

5. Click Save.

6. Click OK in the Restart Information dialog box.

7. Click “Yes, I want to restart my computer now” and click Finish.
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Configuration for Playing Back to a Sony XDCAM SD Device

The generic configuration procedures for playback to all supported devices are described in the 
“Configuring Capture and Playback of MXF DHM OPIa File Formats” on page 74. When you 
configure an XDCAM™ SD device, some settings in the procedures require specific information. 
The following sections provide information about the specific XDCAM SD settings.

n When setting up an XDCAM device for FTP writeback (Send to Playback), set the XDCAM 
device to 16x8 mode (16 bit / 8 channel). The 24x4 mode (24 bit / 4 channels) is not supported 
for FTP writeback.

For procedures on how to transfer files to an XDCAM SD device, see “Workflow: Playing Back 
to an FTP Server” on page 134.

FTP Server Profile Settings for an XDCAM SD Device

For procedures on creating an FTP Server Profile, see “Configuring an FTP Server Profile” on 
page 75. When you add a profile for an XDCAM SD device, set the options in the FTP Server 
dialog box as follows:

FTP Server dialog box 

Settings Description

Profile Name Type a name for the profile 

n The name you assign to the profile appears in the FTP Media 
Browser and Send to Playback list.

Host Name Type the name of the FTP server; device IP address, device DNS Name.

Username admin

n You must use this username.

Password Type the model name of the XDCAM device. For example, PDW-1500.

Server Type Select SONY_XDCAM_PROFILE.

Playback Format Select a playback format from the menu. This option only applies when 
Server Type is set to GENERIC_FTP_PROFILE, 
SONY_XDCAM_PROFILE, OP1A_Export.

FTP Connection Information

   Default Directory Displays the directory on the FTP server where data is sent to or retrieved 
from.
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Port Setting Used for the XDCAM SD Device

Avid Editing Application Setting For Playback to XDCAM SD Device

Configuration for Playing Back to a Sony XDCAM SD 
Device

The generic configuration procedures for playback to all supported devices are described in the 
“Configuring Capture and Playback of MXF DHM OPIa File Formats” on page 74. When you 
configure an XDCAM™ SD device, some settings in the procedures require specific information. 
The following sections provide information about the specific XDCAM SD settings.

n When setting up an XDCAM device for FTP writeback (Send to Playback), set the XDCAM 
device to 16x8 mode (16 bit / 8 channel). The 24x4 mode (24 bit / 4 channels) is not supported 
for FTP writeback.

   FTP Mode Displays the FTP mode as active.

Port Type the FTP connection port. The default is 21.

FTP Server dialog box 

Settings Description

FTP Configuration dialog box

Setting Description

Playback Server area

   Sony FTP Port Type the port number used by the XDCAM device.

Transfer Settings in Avid Editing Application

Setting Description

Output Audio Mix Select Direct channel output - This option lets Send to Playback transfer 
audio tracks without performing a mixdown.

n DVCAM™ requires 1-to-1 audio. Your sequence must contain 4 audio 
tracks.
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For procedures on how to transfer files to an XDCAM SD device, see “Workflow: Playing Back 
to an FTP Server” on page 134.

FTP Server Profile Settings for an XDCAM SD Device

For procedures on creating an FTP Server Profile, see “Configuring an FTP Server Profile” on 
page 75. When you add a profile for an XDCAM SD device, set the options in the FTP Server 
dialog box as follows:

FTP Server dialog box 

Settings Description

Profile Name Type a name for the profile 

n The name you assign to the profile appears in the FTP Media 
Browser and Send to Playback list.

Host Name Type the name of the FTP server; device IP address, device DNS Name.

Username admin

n You must use this username.

Password Type the model name of the XDCAM device. For example, PDW-1500.

Server Type Select SONY_XDCAM_PROFILE.

Playback Format Select a playback format from the menu. This option only applies when 
Server Type is set to GENERIC_FTP_PROFILE, 
SONY_XDCAM_PROFILE, OP1A_Export.

FTP Connection Information

   Default Directory Displays the directory on the FTP server where data is sent to or retrieved 
from.

   FTP Mode Displays the FTP mode as active.

Port Type the FTP connection port. The default is 21.
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Port Setting Used for the XDCAM SD Device

Avid Editing Application Setting For Playback to XDCAM SD Device

Configuration for Working with XDCAM HD and 
XDCAM EX Assets

A complete end-to-end workflow for Long GOP XDCAM HD and XDCAM EX assets is 
available using either an Avid AirSpeed® Multi Stream device, an Omneon server, or a K2 media 
server. Long GOP XDCAM HD media is ingested and available for editing using an Avid editing 
application, and then you use Send to Playback to send the OP1a file to a supported device for 
playback. For more information about XDCAM HD and XDCAM EX workflows, see the 
Interplay Production Best Practices. For a list of supported MPEG-2 operating points, see the 
Interplay Production ReadMe and “Operating Points Qualified for Interplay | Transfer Playback” 
on page 15.

For setup and configuration of the various servers, see the following topics:

• “Configuration for Working with an Omneon Server” on page 100

• “Configuration for Working with an AirSpeed Multi Stream Server” on page 103

When working with Grass Valley K2 Media Server, see the document Working with the Thomson 
Grass Valley K2 Media Server.

FTP Configuration dialog box

Setting Description

Playback Server area

   Sony FTP Port Type the port number used by the XDCAM device.

Transfer Settings in Avid Editing Application

Setting Description

Output Audio Mix Select Direct channel output - This option lets Send to Playback transfer 
audio tracks without performing a mixdown.

n DVCAM™ requires 1-to-1 audio. Your sequence must contain 4 audio 
tracks.
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n Long GOP OP1a sequences that are sent to playback are not copied to the Interplay Access Sent 
to Playback folder. Interplay Transfer, which performs the send to playback, requires AAF 
metadata to perform checkins to Interplay Access. In an OP1a transfer, Interplay Transfer does 
not receive AAF metadata. Instead, it receives the path to an OP1a media file.

Configuration for Working with an Omneon Server

The setup and configuration for working with XDCAM HD and XDCAM EX assets with an 
Omneon server is similar to the procedures described in the “Configuring Capture and Playback 
of MXF DHM OPIa File Formats” on page 74.

The specific configuration for an Omneon server are covered in the following topics:

• “Creating an FTP Server Profile for an Omneon Server” on page 100

• “Port Setting Used For a Omneon Server” on page 101

• “Adding an Omneon Server for Ingesting XDCAM HD and XDCAM EX Formats” on 
page 102

• “Configuring an Interplay | Transfer Client for Ingest From an Omneon Server” on page 102

Creating an FTP Server Profile for an Omneon Server

When adding a profile for a Omneon server using the Interplay Transfer Engine Configuration 
tool, select the options in the FTP Server dialog box as follows:

FTP Server dialog box 

Option Description

Profile Name Type a name for this profile. Don’t include spaces.

n The name you assign to the profile appears in the Send to Playback list.

Host Name Type the name of the Omneon server.

Username Type the Omneon username to connect to the Omneon server.

Password Type the Omneon password to connect to the Omneon server.

Server Type For ingest: Select GENERIC_FTP_PROFILE.

For playback: Select OP1A_EXPORT.

Playback Format (Playback only) Select the playback format for playback of XDCAM HD 
Long GOP material to a Omneon server. For a list of supported resolutions, 
see the Interplay Production ReadMe and “Operating Points Qualified for 
Interplay | Transfer Playback” on page 15.  
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Port Setting Used For a Omneon Server

FTP Connection Information

   Default Directory For playback: Type the name of the folder on the Omneon server where you 
want the Send to Playback to put the files.

   FTP Mode Displays the FTP mode as active.

Port Type the FTP connection port. The default is 21.

FTP Configuration dialog box

Option Description

Playback Server area

   Generic FTP Port Type the port number used by the Omneon server. Avid recommends using 
6534.

FTP Server dialog box 

Option Description
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Adding an Omneon Server for Ingesting XDCAM HD and XDCAM EX Formats

When configuring an Omneon server into your workgroup environment for ingesting, you need 
to add the device to the Interplay Transfer Engine configuration.

To add an Omneon server to your Interplay Transfer Engine configuration:

1. On the Interplay Transfer Engine, click the Start button, and then select All Programs > Avid 
> Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration window opens.

2. In the Ingest area, click Add.

The Ingest Device dialog box opens.

3. Type a profile name.

This profile name must match the profile name set in the FTP Directory Profile Settings 
dialog box for the associated Omneon server. See “Configuring an Interplay | Transfer Client 
for Ingest From an Omneon Server” on page 102.

4. Click OK and then click OK again.
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Configuring an Interplay | Transfer Client for Ingest From an Omneon Server

Before you can ingest media from an Interplay Transfer client (Avid editing system) you need to 
configure the Interplay Transfer client.

• You need to create an FTP directory profile for the Omneon server, see “FTP Directory 
Profile Settings For Ingesting From Omneon Server” on page 102.

FTP Directory Profile Settings For Ingesting From Omneon Server

When a workgroup includes an Omneon server, you need to create an FTP directory profile that 
lets the Omneon server connect with the Avid editing system. For more information about the 
FTP Directory Profile Window Settings dialog box, see, “Creating and Editing FTP Directory 
Profiles on Interplay | Transfer Client” on page 90

n Your entries must match the Omneon server’s network settings.

The Avid FTP Media Browser application is used to ingest from an Omneon server. For 
information, see “Workflow: Capturing Clips From an FTP Server” on page 131.

The following table describes the settings used when creating or editing FTP Directory Profile 
for an Omneon server on an Interplay Transfer Client.

Ftp Directory Profile Window Settings for Omneon Server 

Option Description

Profile Name Name of this profile. The name must match the name used in the Interplay 
Transfer Configuration tool for the ingest device.

Connection Port Displays the port number used by the Omneon server (not the playback port).

FTP Host Name Type the name of the Omneon server. This FTP Host Name must match the Server 
Name assigned during the configuration of the FTP parameter. See “Creating an 
FTP Server Profile for an Omneon Server” on page 100.

User Name Type the Omneon username to connect to the Omneon server.

Password Type the Omneon password to connect to the Omneon server.

Directory Path Type the name of the folder on the Omneon server where the files to ingest are 
located.

Server Type Select GENERIC_FTP_PROFILE.
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Configuration for Working with an AirSpeed Multi Stream Server

AirSpeed Multi Stream is a digital recorder or playback device that lets you capture incoming 
media directly into Avid shared storage or play out media to air. To setup and configure an 
AirSpeed Multi Stream for working with Long GOP XDCAM HD assets in an Interplay 
Production environment, see the Avid AirSpeed Multi Stream Installation and User’s Guide.

n The Interplay Transfer Configuration tool settings are not used to configure an AirSpeed Multi 
Stream. The Avid Service Configuration settings provide settings for configuring an AirSpeed 
Multi Stream.

Before you can transfer from an Avid editing application to an AirSpeed Multi Stream, you need 
to configure the Interplay Transfer Client. For information, see “Allowing Transfers to Other 
Workgroups and Workstations” on page 72.

Configuring a Thunder Production Server
To configure the Interplay Transfer Engine to add a Thunder production server, follow the 
procedures for configuring a Generic FTP device. For the procedures, see “Configuring Capture 
and Playback of MXF DHM OPIa File Formats” on page 74.

In addition to these configuration procedures, the Thunder server needs an ImportWatcher folder 
to hold the files during transfers from the Avid editing system. After the transfers are complete, 
the files are moved from the ImportWatcher folder to the Clip folder in the Thunder server’s 
database. The files in the Clip folder are used during a transfer from the Thunder server to the 
Avid editing system.

n To transfer files to or from a Thunder server, the Interplay Transfer Engine requires the 
“Interplay Transfer Server with Supplemental FTP Services” option during installation. 

FTP Mode Displays the FTP mode as Active.

Force UTF-8 names 
from server

Select this option when using clips that contain non-English characters. Fixes a 
problem where clips containing non-English characters did not update correctly in 
the Media Services Transfer Status window.

Ftp Directory Profile Window Settings for Omneon Server 

Option Description
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Before you can transfer files, the Thunder server requires the following setup:

• Verify the Thunder server has at least one database.

• Verify the Thunder server and all Avid editing systems have the same timecode settings 
(Drop Frame or non-Drop Frame) and video standard (NTSC or PAL).

• Set up and enable the ImportWatcher folder.

• Install and configure the third-party FTP server software to create a Send user and a Retrieve 
user that match the users set up on the Avid editing system. 

For setup procedures, see the Thunder documentation. For procedures on how to transfer files to 
and from a Thunder server, see “Transferring To and From Generic FTP Servers” on page 130. 

Configuring Ingest From FTP Deck Devices
TM-DHM is Avid’s API to integrate with third-party video server vendors. Avid has written its 
own integration to the DHM API for the Sony e-VTR and XDCAM deck devices. The 
integration supports MXF files by rewrapping them in AAF (MXF workgroup) as they are 
brought into Avid shared storage through the Interplay Transfer Engine. You need to configure 
the FTP deck device before you can capture media from it. For procedures on how to capture 
clips, see“Transferring Files From FTP Deck Devices” on page 135.

The following configuration and setup steps are required to integrate a FTP device into a 
workgroup.

To integrate a FTP device into a workgroup:

1. Select “Interplay Transfer Engine Server with Supplemental FTP Services” as the 
installation type when installing the Interplay Transfer Engine application.

See “Installing the Interplay | Transfer Engine in a Workgroup Environment” on page 26

2. Add the ingest device to the Interplay Transfer Engine configuration.

See “Adding FTP Ingest Devices into an Interplay | Transfer Engine Configuration” on 
page 105.

3. Set up the device connection from the Avid editing system. 

For the connection setup procedure, see “Setting the Ingest Device Connection” on 
page 107.

4. Capture the clips from a FTP device.

See “Transferring Files From FTP Deck Devices” on page 135.
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Adding FTP Ingest Devices into an Interplay | Transfer Engine 
Configuration

When configuring an FTP ingest device into your workgroup environment, you need to add the 
device to the Interplay Transfer Engine configuration.

To add an FTP ingest device to your Interplay Transfer Engine configuration:

1. On the Interplay Transfer Engine, click the Start button, and then select All Programs > Avid 
> Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration window opens.

2. In the Ingest area, click Add.

The Device dialog box opens.

3. Type the name associated with the ingest device on the network, for example evtr_wu.

4. Click OK.

5. (Option) Add an ingest catalog. 

See “Configuring an Ingest Device Catalog” on page 109.

6. Make sure the Workgroup Settings are set correctly. 

See the table in “Interplay | Transfer Engine Configuration Settings” on page 36.

7. Click Save.
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Setting the Ingest Device Connection

When a workgroup includes an FTP device, you need to set the device connection from the Avid 
editing system.

To set up a connection to ingest from FTP devices, such as a Sony XDCAM:

1. From the Avid editing system, click the Start button, and then select All Programs > Avid > 
Utilities > FTPClipList.

The FTPClipList dialog box opens.
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2. Click Add a Device or Reconfigure a Device.

The Connection Settings dialog box opens.

3. Type the setup information for the device you are configuring, your entries must match the 
device’s network settings.

See “Connection Settings For Ingest Device” on page 109.

4. Click OK.
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Connection Settings For Ingest Device

The following table describes the settings available on the Connection Settings dialog box that is 
accessed from the FTPClipList dialog box.

For information on setting the ingest device connections, see “Setting the Ingest Device 
Connection” on page 107.

Configuring an Ingest Device Catalog
When configuring an ingest device into your workgroup environment, you can associate a 
Interplay Access Catalog with the ingest device. The ingest catalog contains master clips of the 
media created during successful ingest transfers. You can associate more than one ingest device 
to a catalog. The ingest catalog is a regular Interplay Access catalog using the same display, 
access control, and delete rules. 

When the first ingest occurs after you set up an ingest catalog, the Interplay Transfer Engine 
creates the catalog in the Interplay Access tree view.

Associating a catalog with an ingest device does not effect the usual process of checking in 
ingested clips to a workspace.

Connection Settings Dialog Box 

Setting Description

Your name for Device Type a name to identify the device.

Host Name Device’s network server name. This host name must match the host name listed 
in the ingest device list in the Interplay Transfer Engine Configuration window.

Login Device’s login name.

Password Device’s password.

Device Type Select the type of device.

Video Rate Select the video rate - for example, IMX 30, 40, 50, or DVCAM. Your selection 
must match the set rate of the device.

Signal Standard Select PAL or NTSC. Your selection must match the setting of the device.

Directory Displays the default directory where the source media is located on the FTP 
device for ingesting.

Audio Tracks Select the number of audio tracks you want to ingest (2, 4, 6, or 8).
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n The ingest catalog feature is not available with AirSpeed.

To associate an Interplay Access Catalog with an ingest device:

1. On the Interplay Transfer Engine, click Start, and then select All Programs > Avid > 
Interplay Transfer Engine Configuration.

2. In the Ingest area, select an ingest device and click Edit.

The Device dialog box opens.

3. Select Enter Ingest Catalog name.

4. Type a name for the ingest catalog.

The catalog name you enter displays in the Interplay Access when the first ingest occurs.

5. Click OK.

The catalog name displays inside square brackets and next to the ingest device name.

For example, HKELLYHPXP [Cat1], where HKELLYHPXP is the ingest device name and 
Cat1 is the catalog name.

6. Click Save.

7. Restart the Interplay Transfer Engine server.
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Configuring a Playback Device Catalog
When configuring a playback device into your workgroup environment, you can associate an 
Interplay Access Catalog with the playback device. The playback catalog contains clips of the 
media and all its relatives, including the .transfer sequences, that successfully transfer to the 
playback device. You can associate more than one playback device to a catalog. The playback 
catalog is a regular Interplay Access catalog using the same rules for display, access control, and 
delete. 

n The playback catalog feature is not available with AirSpeed Classic or AirSpeed Multi Stream.

To associate an Interplay Access Catalog with a playback device:

1. On the Interplay Transfer Engine, click Start then select All Programs > Avid > Interplay 
Transfer Engine Configuration.

2. In the Playback area, select a playback device and click Edit.

The Playback Device dialog box opens.

3. Select Enable Playback Catalog name.

4. Type a name for the playback catalog.

The catalog name you enter displays in the Interplay Access Catalog when the first transfer 
occurs.

5. Click OK.

6. Click Save.

7. Restart the Interplay Transfer Engine server.
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Configuring the Interplay | Auto Transfer Service
This section describes how to use the Avid Service Configuration to configure the Interplay 
AutoTransfer service. Avid Service Configuration is an application that lets you set and change 
parameters for each of the different Avid services and applications in your workgroup 
environment.

To configure the Interplay Auto Transfer service using Interplay Framework:

1. On any system with the Interplay Service Configuration application installed, click the Start 
button, and select All Programs > Avid > Interplay Framework > Avid Service 
Configuration.

The Select Workgroup dialog box opens.

n The Select Workgroup dialog box does not open if the option specifying to always select and use 
this workgroup option was previously selected. When you select this option, the Select 
Workgroup dialog box no longer opens when you start the application. The default workgroup is 
selected, and the Avid Service Configuration window opens.

2. Select the workgroup to which you want to connect and click Select.

The Avid Service Configuration window opens.

3. In the Directory pane, click the Processes tab and verify that the Interplay Automatic 
Archive, Transcode, and Transfer process is running.

n If the Interplay Automatic Archive, Transcode, and Transfer service does not appear in the Avid 
Service Configuration window, then the service is not running or the system it runs on is not 
properly connected to the workgroup. Click the Hosts tab and make sure that the Service 
Framework services displays the name of the system that the Interplay Automatic Archive, 
Transcode, and Transfer service is running on.

4. Expand the Interplay Automatic Archive, Transcode, and Transfer service entry in the 
Directory pane.

The system displays the name of the computer running the Interplay Automatic Archive, 
Transcode, and Transfer services.
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5. Click the computer name.

The Administrator Password Needed dialog box opens.

6. Type the Interplay Framework Administrator password and click OK.

n By default, Interplay Framework does not require a password. When a password is used, it is set 
through the System Configuration Service. Check with your system administrator for the correct 
password.

The system displays the Workgroup Server Setting tab for the Interplay Automatic Archive, 
Transcode, Transfer, and Copy services.

7. Type the Interplay Engine hostname, user name, and password.
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8. Click the Transfer and Transcode Settings tab.

The system displays the settings for the Interplay AutoTransfer and AutoTranscode.

9. In the Configure Interplay AutoTransfer area, do the following:

a. Enable AutoTransfer—Select Yes.

b. AutoTransfer scanning interval—Type the number of minutes between scans, minimum 
allowed is 3 minutes.

c. Number of times to retry when encountering an error—Type the number of times you 
want the system to retry after an error occurs.

d. Number of clips to submit to Interplay Transfer Engine at once—Type the number of 
clips you want sent for transfer at one time.
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10. Click Apply. 

11. Close the Avid Service Configuration window.

n When configuration changes are made and the Apply or Reset button is not clicked prior to 
changing a selection or closing the window, a dialog box appears reminding you to Apply or 
Reset the configuration.



4 Transferring Avid Assets

This chapter describes how to transfer Avid assets. You can transfer assets to another workgroup 
or to any supported media servers.

Before you can transfer assets, you must configure the Interplay Transfer Engine components. 
For configuration procedures, see “Interplay | Transfer Engine Configuration Settings” on 
page 36.

This chapter discusses the following topics:

• Media Compatibility Between Avid Applications

• Transferring Avid Assets from an Avid Editing Application

• Transferring Avid Assets from an Interplay | Production Workgroup to Another Workgroup

• Automatically Transferring Assets to Another Workgroup

• Transferring Avid Assets in a Standalone Environment

• Transferring Avid Assets to a Playback Device (Send to Playback)

• Transferring Files From an Ingest Device

• Transferring To and From Generic FTP Servers

• Transferring Files From FTP Deck Devices

Media Compatibility Between Avid Applications
The type of system on which your application is running determines what can be sent between 
systems. Before you transfer data between Avid applications, consider whether the media files, 
metadata, or compositions are compatible between applications.

For additional information about compatibility, see the documentation provided with your Avid 
editing system.
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Transferring Avid Assets from an Avid Editing 
Application

If Interplay Transfer Engine is properly installed and enabled on your Avid editing system, it 
starts automatically whenever you start the Avid editing application. When you complete a 
sequence, you can transfer it from the Avid editing application to any other connected workgroup 
or to a playback device. Once you send the sequence, you can work on another project while the 
transfer is taking place.

For information about configuring the Avid editing application for transferring assets, see 
“Configuring the Avid Editing Application for Transfers” on page 69.

To send clips or sequences to another workgroup from within the Avid editing application:

1. Open the bin that contains the clips or sequences you want to send.

2. Select a clip or sequence, or Ctrl+click multiple clips or sequences.

3. Select Transfer > Send To Workgroup and then select the available workgroup to which you 
want to send the assets.

The assets are sent to the Interplay Transfer Engine server, where they are then sent to the 
selected workgroup. You can now work on another project while the transfer is taking place.

For information on monitoring the transfer of assets, see “Monitoring Transfers from Within 
the Avid Editing Application” on page 149.

Transferring Avid Assets from an 
Interplay | Production Workgroup to Another 
Workgroup

The Avid Interplay Access lets you use Interplay Transfer Engine to transfer assets from one 
workgroup to another. The workgroup you are transferring the asset to can be either an Interplay 
workgroup or a Workgroup 4.5 MXF/AAF workgroup.

n You cannot transfer Interplay Production assets to a Workgroup 4.5 OMF workgroup.

Before you can transfer assets to another workgroup, the remote workgroup must be registered in 
your local workgroup. The remote workgroups are configured in the Configure Remote 
Workgroups view in the Avid Interplay Administrator. All configured remote workgroups 
display in the Destination tree of the Send to Workgroup dialog box. For information about 
registering a remote workgroup, see “Configuring a Remote Workgroup for 
Workgroup-to-Workgroup Transfers” on page 57.
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You can use presets to select a predefined destination for the transferring assets. For procedures 
on configuring transfer presets, see “Configuring Workgroup Transfer Presets” on page 47.

To transfer Avid assets to another workgroup:

1. If you have not already done so, start your local Avid Interplay Access by clicking Start and 
selecting All Programs > Avid > Avid Interplay Access.

2. Start the remote Avid Interplay Access.

3. In your local Avid Interplay Access, select the assets that you want to transfer to the remote 
Avid Interplay Access.

n The assets you select must be Avid assets. You cannot transfer file assets, such as folders or 
graphic files.

4. Select Tools > Send to Workgroup.

The Send to Workgroup dialog box opens. Green folders in the Destination list specify 
MediaManager and TransferManager workgroups.
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5. Select a destination folder for transferring the assets by doing one of the following:

- If your workgroup configuration contains presets, then you can select a preset from the 
Destination Preset menu to set the destination folder and workspace.

n Destination Presets are configured using the Interplay Transfer Engine Preset view in the Avid 
Interplay Administrator. If no presets are configured, the Destination Preset menu does not 
appear in the Send to Workgroup dialog box. For procedures on configuring a transfer preset, 
see “Configuring Workgroup Transfer Presets” on page 47.

- If your workgroup configuration contains presets, but you do not want to use a preset, do 
the following:

- From the Destination Preset menu, select None.

- In the Destination area, select the remote workgroup and if applicable select a folder 
where you want to transfer the metadata.

- From the Workspace menu, if applicable select the workspace where you want to 
transfer the media file.

- If presets are not available, do the following:

- In the Destination area, select the remote workgroup and if applicable select a folder 
where you want to transfer the metadata.

- From the Workspace menu, if applicable select the workspace where you want to 
transfer the media file.

If you do not select a preset destination, the settings available in the Send to Workgroup 
dialog box depends on the type of remote workgroup. See “Explanation of Send to 
Workgroup Settings” on page 119.

6. (Option) If you want to monitor the transfer, select the “Launch Interplay Transfer Status 
window.”

7. Click OK.

The transfer begins.

Explanation of Send to Workgroup Settings

When you perform a workgroup-to-workgroup transfer, the settings available in the Send to 
Workgroup dialog box depend on the type of remote workgroup selected. A Host Type is set 
when the remote workgroup is registered in the local workgroup. Remote workgroups are 
registered using the Configure Remote Workgroups view in the Avid Interplay Administrator. 
For information on registering a remote workgroup, see “Configuring a Remote Workgroup for 
Workgroup-to-Workgroup Transfers” on page 57.

n When setting up Transfer Presets, the limitations described in this section also apply.
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When registering remote workgroups, use the following table to understand the various Host 
Types for the remote workgroups and the settings that are available in the Send to Workgroup 
dialog box with each type of host.

Transferring Avid Assets from Workgroup 4.5 to an Interplay | Production 
Workgroup

You can transfer Avid assets from Workgroup 4.5 to an Interplay workgroup. The 
MediaManager server in the Workgroup 4.5 environment must have TransferManager installed 
and configured.

n Interplay Engine and MediaManager cannot run simultaneously on a single Avid shared storage 
system.

To transfer Avid assets from Workgroup 4.5 to an Interplay workgroup:

1. From the Avid Interplay Administrator, click Interplay Transfer Engine Status.

The Interplay Transfer Engine Status dialog box opens.

2. Open the MediaManager in a browser.

3. Perform a search operation that returns the assets that you want to transfer.

4. In the Results Frame of the MediaManager, click the asset, or Ctrl+click multiple assets that 
you want to transfer and drag them to the Interplay Transfer Engine Status dialog box.

Host Type
Send to Workgroup 
setting Description

Interplay Production 
Server/Remote Search

Destination folder Lets you select a folder for the incoming metadata on 
the remote Interplay workgroup.

Workspace Lets you select a workspace for the transferred assets.

MediaManager Destination folder You cannot select a destination folder.

Workspace Lets you select a workspace for the transferred assets.

TransferManager Destination folder You cannot select a destination folder. 

Workspace You cannot change the workspace here. Uses the 
default workspace set in “No-login workspace for 
incoming transfers” in the Interplay Transfer Engine 
Configuration tool or for Workgroup 4 
TransferManager in the Avid TransferManager Server 
Configuration tool.
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The Interplay Transfer Engine begins a “pull” of the asset from the Workgroup 4.5 
TransferManager. The assets are added to the default folder, for example, Incoming Media 
folder.

Automatically Transferring Assets to Another 
Workgroup

The Interplay AutoTransfer service lets an administrator or user with administrator privileges 
identify a folder as an AutoTransfer folder. The Interplay AutoTransfer service automatically 
submits assets placed in the AutoTransfer folder to the Interplay Transfer Engine for 
workgroup-to-workgroup transfers. When setting up an AutoTransfer folder you select a 
Transfer Preset that defines the destination workgroup, workspace for the media files, and 
destination folder for the metadata. 

When a clip or sequence asset is placed in a folder identified as an AutoTransfer folder, the 
system uses the Interplay Transfer Preset associated with the AutoTransfer folder to 
automatically transfer the asset.

You should create only the minimum number of AutoTransfer folders that you need. The 
Interplay AutoTransfer service regularly scans all auto folders, so if there are a lot of folders to 
scan, there can be an impact on the performance of the Interplay Engine.

The Avid Service Framework provides the following tools for Interplay AutoTransfer service:

• Avid Workgroup Properties tool starts and stops the service.

• Avid Service Configuration tool:

- Requires initial setup for setting the source Interplay Engine server and setting a user 
name for the service and a password for the login user name.

- Lets you set and change parameters for each of the different Avid services and 
applications in your workgroup environment.

• Avid Health Viewer tool monitors the status of the service.

• Avid Diagnostic Log Viewer checks details about errors of the service.

For more information about Avid Service Framework, see the Avid Service Framework User’s 
Guide.
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Check List for Automatic Transfer

The following table provides a check list for setting up an AutoTransfer folder and using the 
folder to automatically transfer assets.

Identify an AutoTransfer Folder

Before you can setup an AutoTransfer folder, a Transfer Preset must already exist. For 
information on creating a Transfer Preset, see “Configuring Workgroup Transfer Presets” on 
page 47.

To set up an AutoTransfer folder:

1. Log on to Interplay Engine as an administrator or as a user with administrator privileges.

2. Create a folder (or select an existing folder) in the Interplay Production database, using 
Interplay Access.

You can use any name for the folder that fits your workflow.

3. Right-click the folder and select Set AutoTransfer.

The Set AutoTransfer dialog box opens.

4. Select a Transfer Preset for the folder and click Set.

The system adds an Interplay AutoTransfer icon to the folder.

Task Section Reference

 Install the Interplay 
AutoTransfer service. 

 See “Installing the Interplay |  Auto Media Services Service” on 
page 29.

 Configure the Interplay 
AutoTransfer service settings.

See “Configuring the Interplay | Auto Transfer Service” on 
page 112.

 Create a Transfer Preset for 
AutoTransfer folder.

See “Configuring Workgroup Transfer Presets” on page 47.

 Identify a folder as an 
AutoTransfer folder.

See “Identify an AutoTransfer Folder” on page 122.

 Transfer assets using an 
AutoTransfer folder.

See “Automatically Transferring Assets” on page 123.

 Monitor transfers Use Service Framework, see the Avid Service Framework User’s 
Guide.
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Automatically Transferring Assets

To automatically transfer assets:

1. Make sure a folder is configured for Interplay AutoTransfer. 

See “Identify an AutoTransfer Folder” on page 122.

2. Locate a clip that you want to transfer, right-click the file, and select Move To.

The Move To dialog box opens.

3. Navigate to your AutoTransfer folder and click OK.

The system starts transferring the assets to the destinations set in the Transfer Preset, as a 
background task.

4. (Option) To view the progress of the transfer, select Tools > Interplay Transfer Status.

The status window opens and displays the transfer status of all jobs being transferred.

Rules of AutoTransfer

To determine if the clips are ready for transfer, a set of rules is applied to each clip found in the 
AutoTransfer folder.

AutoTransfer rules applied after Interplay AutoTransfer service starts are as follows:

• Verifies clips are inside the AutoTransfer folder.

• Verifies that clips are not in Frame Chase Editing (Edit While Capture) mode.

• Verifies clips are not already pending for a transfer in Interplay Transfer.

• Verifies clips have not already successfully transferred.

• Verifies clips have been modified since the last successful AutoTransfer—if the clips were 
modified after a successful AutoTransfer, the clips will be AutoTransferred again.

Transferring Avid Assets in a Standalone 
Environment

In a standalone environment, Interplay Transfer Engine can be used to transfer compositions and 
media from one Avid editing system to another Avid editing system. If you are transferring 
compositions or clips, you select the item from a bin and transfer it. If data is being sent to you 
from another Avid editing system, you choose to accept it.
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To transfer assets between Avid editing systems, each Avid editing system must have the 
Interplay Transfer Engine and Interplay Transfer client installed. If Interplay Transfer Engine is 
properly installed and enabled on your Avid editing system, it starts automatically whenever you 
start the Avid editing application.

After you send a sequence to another Avid system, you can work on another project while the 
transfer is taking place. However, until the transfer operation is complete, certain operations 
might run more slowly. In the case of play back and capturing, you might experience 
interruptions.

For procedures on configuring your Avid editing system for transfers, see “Configuring the Avid 
Editing Application for Transfers” on page 69.

Transferring Avid Assets to Another Avid Editing System

To send clips or sequences to another Avid editing system:

1. Open the bin that contains the clips or sequences you want to send.

2. Select a clip or sequence, or Ctrl+click multiple clips or sequences.

3. Select Transfer > Send To Workgroup and then select the available workstation to which you 
want to send the assets.

The compositions, clips, and any available media are sent to the destination system.

For information on monitoring the transfer of the assets, see “Monitoring Transfers from Within 
the Avid Editing Application” on page 149.

Transferring Avid Assets to a Playback Device (Send 
to Playback)

In a broadcast environment, you can transfer a finished sequence to a configured playback device 
(referred to as Send to Playback or STP). For information about configuring the playback device 
for transfers, see “Interplay | Transfer Engine Configuration Settings” on page 36.

To send a finished sequence to a playback device:

1. In an Avid editing application, open the bin that contains the sequence you want to transfer.

2. Select the sequence. 
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3. Select Transfer > Send To Playback, and select the available playback device to which you 
want to send the sequence.

The Send to Playback dialog box opens.

4. (Option) If you want to send the sequence with high priority and if you want the asset to play 
before the transfer to the playback device is finished, click the circle in the PWT (Play While 
Transferring) column next to the sequence. (This option is labeled High Priority in Interplay 
Assist and Avid Instinct). 

5. (Option) If you want to overwrite any sequence with the same tape ID already sent to the 
playback device, click the check box in the Overwrite column next to the sequence.

c If you try to send a sequence with a tape ID that already exists on the playback device, you 
receive an error message. Select the Overwrite option only if you are sure you want to 
overwrite any sequence with the same tape ID.

6. Click OK.

The sequence is sent to the Interplay Transfer Engine server, where it is sent to the selected 
playback device. You can now work on another project while the transfer is taking place.

For information on monitoring the transfer of assets, see “Monitoring Transfers from Within 
the Avid Editing Application” on page 149.

Working with Rundowns

In a broadcast environment, you can enable the Interplay Transfer Engine scheduling feature to 
allow interaction with the Newsroom Computer System (NRCS). You can select the assets to 
send to playback, and the schedule list from the NRCS determines the order in which the assets 
are played back.
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To use the Interplay Transfer Engine with rundowns:

1. On your Interplay Transfer Engine server, click Start, and select All Programs > Avid > 
Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration window opens.

2. In the Playlist Information area, select “Use Newsroom rundowns to schedule transfers.”

3. Type the computer name of the Newsroom Server.

4. Type the user name and password.

5. If you know the name of the schedule file, type it in the Schedule File Name text box.

The schedule file specifies which rundowns to use at which time. See “Creating a Rundown 
Schedule File” on page 127.

6. Click OK.

7. Restart the Interplay Transfer Engine server. 

Anytime the configuration information changes, you must restart the server.

8. On your Avid editing system, open the bin that contains the sequences you want to send.

9. Select the sequences.

10. Select Transfer > Send To Playback and select the available playback device to which you 
want to send the sequence.

The Send to Playback dialog box opens.
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11. Click OK.

The sequences play back based upon the order in which they appear in the NRCS rundown 
list.

In the Send to Playback dialog box, if you set one of the sequences to high priority by 
clicking the circle in the PWT column next to the sequence, that sequence has priority over 
the rundown list.

For information on monitoring the transfer of assets, see “Monitoring Transfers” on page 149.

Creating a Rundown Schedule File

A rundown schedule file tells the Interplay Transfer Engine server which rundown to schedule at 
what time. The format is the time to start monitoring the rundown followed by the name of the 
rundown. A sample rundown schedule is as follows:

# Rundown Schedule File 
# Number of elements 
9 
#Time (after) Rundown Name 
00:00:00 5a 
05:55:00 6a 
06:55:00 7a 
11:45:00 noon 
14:45:00 3pmcutin 
15:45:00 4pmcutin 
17:55:00 6p 
20:45:00 9pmcutin 
21:10:00 10p 

Transcoding of Mixed Resolution Clips During a Send to Playback

When you perform a Send to Playback operation, the application automatically renders effects 
and relinks your sequence to the target resolution. You can use the Send to Playback command 
with sequences that contain clips of different resolutions. Any clips in the sequence with 
resolutions not matching the target resolution settings in the Dynamic Relink dialog box are 
transcoded to the target resolution. The application creates a new master clip (with the extension 
.new) and associates the new clip with the new transcoded media.

Before the Send to Play operation begins, the application searches the sequence for any clips 
with an undesirable resolution for the transcode operation, such as clips with low resolutions that 
would create a low quality output after the clip is transcoded. If clips are found, a warning 
message is displayed to let you decide if the Send to Play operation should continue with a lower 
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quality output. You can set the minimum resolution allowed before displaying the warning 
message by using the Transfer Settings dialog box. For setup information, see “Configuring the 
Avid Editing Application for Transfers” on page 69.

n Dynamic Relink must be enabled to use the Transcode before sending to playback option. For 
information about using Dynamic Relink, see the Avid editing application Help system.

XDCAM HD Send to Playback Acceleration

You can initiate the play while transfer (PWT) of an XDCAM HD clip or sequence to AirSpeed 
Multi Stream shortly after you begin the Send to Playback (STP) operation. Previously, you had 
to wait until the system exported the clip before you could begin playback.

This feature requires the following:

• Specific versions of the following applications: 

- Media Composer v5.5.1, Symphony v5.5.1, or NewsCutter v9.5.1, or later. 

- Interplay Assist v2.3 or later

- Avid Instinct v3.5 or later

• Airspeed Multi Stream v1.7 or later

• XDCAM HD material

You can use the play while transfer feature with the STP Encode background processing service. 
For information on STP Encode, see the Interplay | Production Services Setup and User’s Guide 
or the Interplay Production Help.

If the correct versions of the editors or AirSpeed Multi Stream are not available, the system uses 
the older STP method where the clip is exported before playback begins.

Transferring Files From an Ingest Device
In a broadcast environment, you can transfer files from a configured ingest device to your Avid 
editing system bin.

To transfer files from the ingest device to your Avid editing system bin:

1. Ensure that the ingest device is properly connected. 

For more information, see the documentation supplied with your ingest device.

2. Open the ingest device’s application that lets you see the files located on the ingest device. 

A list of files located on the ingest device appears.

3. Open the bin on your Avid editing system where you want to capture the files.



Transferring Files From an Ingest Device

129

You might have to minimize both the Avid editing application and the ingest device’s 
application so that you can view both at the same time on your desktop.

4. Click the media file you want to capture, and drag the file to your Avid editing system bin.

If you selected one item to transfer, a message appears asking if you want to initiate the 
transfer.

5. Do one of the following:

t Click Later, if you wait to transfer the asset at a later time. To transfer the asset at a later 
time, select Transfer > Retrieve.

t Click Now to transfer the assets. 

The captured assets appear in the bin. To monitor the transfer, see “Monitoring Transfers” on 
page 149.

If you selected multiple items to transfer, a message box opens, asking if you want to initiate 
the transfer. 

6. Do one of the following:

t Click Transfer; a message box appears for each clip. You must click OK in each 
message box to initiate the transfers.

t Click Transfer All; all the items selected are transferred.
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t Click Defer; the assets are not transferred, and you see a message box to defer each 
asset. You must click OK in each message box to defer the transfers.

t Click Defer All; the assets are not transferred until you retrieve them. To transfer the 
assets at a later time, select Transfer > Retrieve.

The captured assets appear in the bin. To monitor the transfer, see “Monitoring Transfers” on 
page 149.

Transferring To and From Generic FTP Servers
To enable interoperability between Interplay Production and third-party devices that use the 
MXF OP1a file format, Avid has developed an optional Data Handling Module (DHM) plug-in 
for Interplay Transfer Engine that supports FTP integration to third-party MXF OP1a compliant 
devices. The Interplay Transfer Engine MXF OP1a FTP DHM allows MXF OP1a files to be 
brought into Avid shared storage or an Avid editing environment from an FTP server. You can 
also export Avid media files in MXF OP1a format to an FTP server using this same MXF OP1a 
FTP DHM.

For MXF OP-1A files created by the FTP-DHM, the MXF Filler universal label (that is part of 
the file’s internal metadata) is now as close as possible to being SMPTE MXF-compliant. This 
change might create an issue for older MXF decoders that have not been updated to take into 
account both universal labels in use:

For procedures required to integrate a FTP server into a workgroup, see “Configuring Capture 
and Playback of MXF DHM OPIa File Formats” on page 74.

The Avid FTP Media Browser application allows you to browse the contents of an FTP server to 
select the MXF OP1a files that you want to import into the Avid system. The MXF OP1a FTP 
DHM rewraps the imported files in Avid MXF-OP-Atom format.

n Avid editing applications do not play IMX files that are encoded on the Thunder system and then 
ingested into the Avid editing application. The media is always located in a Clips folder in each 
database.

The Interplay Transfer Engine MXF OP1a FTP DHM was written to support MXF OP1a files 
that match the MXF OP1a reference standard. Because some vendors implement MXF OP1a 
support in a way that deviates from the reference standard, Avid cannot guarantee support for 

MXF Filler Style SMPTE Universal Label

Legacy 06.0e.2b.34.01.01.01.01.03.01.02.10.01.00.00.00

RP210-compliant 06.0e.2b.34.01.01.01.02.03.01.02.10.01.00.00.00
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devices that do not comply with the reference standard. In addition, Play While Transfer, 
Overwrite, Frame-Chase Editing, and partial-transfer capabilities are not supported with the 
MXF OP1a FTP DHM.

Interplay Transfer Engine supports capture from and play back to File Transfer Protocol (FTP) 
servers that are compliant with FTP. You can transfer completed media sequences between Avid 
editing applications and generic FTP type servers.

The FTP transfer of media is over standard TCP/IP Ethernet network. The FTP DHM supports 
connections to a FTP server using a valid DNS name or IP address. The FTP DHM can work 
with FTP servers on different subnets than the Interplay Transfer Engine server.

n Microsoft .NET Framework 1.1 must be installed on the Interplay Transfer Engine server and 
Interplay Transfer Engine client systems when you are using FTP DHM. You can install .NET 
Framework during the Interplay Transfer Engine installation.

During the transfer, the FTP DHM component supports the Run, Pause, Resume, Retry, and 
Cancel functions that are available from the Interplay Transfer Engine server. Pause and Resume 
functions are constrained by the time-out setting on the FTP server. The components support 
multi-threaded operations that allow for simultaneous transfer operations to occur.

n If you cancel a transfer before it is complete, the part of the transfer that succeeded before the 
cancellation remains on the server.

For FTP transfer workflows, see the following sections:

• “Workflow: Capturing Clips From an FTP Server” on page 131

• “Workflow: Playing Back to an FTP Server” on page 134

Workflow: Capturing Clips From an FTP Server

During an ingest, compressed frames are streamed from MXF OP1a files stored on a generic 
FTP server to the Avid editing system. Captured files do not overwrite an already existing file. If 
a file already exists, a new file is created.

The audio or video format of the media is maintained during the capture process. Therefore, 
there is no visible or measurable distortion of either video or audio as a result of the transfer 
process. 
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There are two methods for capturing clips from an FTP server:

• Drag and drop items to an Avid editing application bin.

• Direct Capture lets an Interplay Transfer client capture media from FTP servers into a 
default workgroup and workspace. The destination of the captured items is set when you 
configure the workgroup and workspace in the Interplay Transfer Engine Configuration tool. 
This workflow provides unattended ingests of selected items. 

To capture media from an FTP server:

1. Make sure the FTP server is properly connected and configured; see the documentation that 
came with your server.

2. (Option) When using drag and drop method, open a bin or create a new bin and position it in 
an unobstructed area.

3. From the Avid Transfer client system, click the Start button, and then select All Programs > 
Avid > Utilities > Avid FTP Media Browser.

The Avid - FTP Media Browser opens.

Connect status

Media list Profile menu Media Transfer Support listEdit button
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4. Select a Profile from the Profile menu for the FTP directory where you want to access the 
media files. 

The status bar at the bottom of the Avid - FTP Media Browser window displays the 
hostname and directory path for the currently selected profile.

n For a procedure on how to create a new profile, see “Creating and Editing FTP Directory 
Profiles on Interplay | Transfer Client” on page 90.

5. Observe the connection status box.

This box indicates when the connection is complete. When the connection is complete, a list 
of files in the FTP directory displays in the Media List.

If no activity occurs for a time-out period, the FTP connection is closed. Click Update to 
reconnect to the FTP server.

6. (Option) Sort the files listed in the Media List by name, modification date, or size.

7. (Option) Click Update to refresh the list of files in the Media List.

8. Select the files in the Media List that you want to transfer.

9. Click Add to add the selected files to the Media Transfer Support list.

10. (Option) Click Remove to move a selected file from the Media Transfer Support list back to 
the Media List.

11. (Option) Double-click a file in the Media Transfer Support list to open a status window 
where you can set IN and OUT points and view information about the clip.

12. (Option) When using Direct Capture method, you need to configure the Interplay Transfer 
client. 

See “Configuring the Interplay | Transfer Client For Direct Captures” on page 94.

Connection Status

Color Indicates

Green Connected

Gray Not connected

Red Connection failed
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13. Begin the transfer by doing one of the following:

t Drag and Drop method—select the files in the Media Transfer Support list and drag 
them to the Avid editing application bin.

A dialog box opens asking if you want to transfer the files now or defer the process to a 
later time. Click Now to begin the transfer or click Later to defer the transfer to a later 
time.

t Direct Capture method—click Initiate Transfer.

Items listed in the Media Transfer Support list begin transferring one at time until the 
list is finished. The destination of the captured items is set when you configure the 
workgroup and workspace in the Avid Interplay Transfer Engine Configuration tool.

14. Monitor the transfer progress using the Transfer Status column. The Transfer Status column 
displays Submitted, Pending, or a percentage of the completed capture, as the transfers are 
monitored every 2 seconds.

Using the FTP Media Browse Interface

The following summarizes features of the FTP Media Browse window:

• The Edit button launches the FTP Source window. This provides the same functionality as 
right-clicking on the Profile box and selecting Open Profile Window.

• The status bar along the bottom of the window provides information similar to Windows 
Explorer:

- File details of selected item. If you select more than one item the system displays the 
total number selected.

- File size of selected items in the Media List window. If you select multiple items the 
system shows the total file sizes of all the items. 

• The window provides standard windows keyboard support for file selection. For example:

- (CTRL-A) -Select All

- (ALT-A) - Add, (ALT-E) - Edit, etc.

Workflow: Playing Back to an FTP Server

During a playback operation, media associated with a sequence from an Avid editing application 
is transferred to a FTP server. The media format in the Avid environment is MXF/AAF. The 
format of the data transferred to the FTP server is MXF OP1a. However, the audio and video 
quality remains the same as the native Avid media. There is no visible or measurable distortion 
of either the video or audio as a result of the transfer process, and the transfer preserves the 
original media format (DV or IMX).
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The name in the Tape ID field of the sequence is used as the name for the file created on the FTP 
server during a play back.

n For configuration information for playback to an XDCAM SD device, see “Configuration for 
Playing Back to a Sony XDCAM SD Device” on page 96.

To play back a sequence to an FTP server:

1. Make sure the FTP server is properly connected and configured; see the documentation that 
came with your server.

2. Make sure the “Interplay Transfer Engine with Supplemental FTP Services” setting was 
selected as the installation type during the installation of the Interplay Transfer Engine 
application. 

See “Installing the Interplay | Transfer Engine in a Workgroup Environment” on page 26.

3. Make sure the Interplay Transfer Engine server is configured with the FTP server and FTP 
playback device. 

See “Capturing Clips From FTP Devices” on page 137.

4. On the Avid editing system, select the sequence you want to play back.

5. Select Transfer > Send to Playback > Generic FTP playback device.

Generic FTP playback device is the device you added to the Interplay Transfer Engine 
Configuration tool. See “Configuring a Generic FTP Playback Device into a Workgroup” on 
page 82.

The playback transfer begins.

Transferring Files From FTP Deck Devices
TM-DHM is Avid’s API to integrate with third-party video server vendors. Avid has written its 
own integration to the DHM API for the Sony e-VTR and XDCAM deck devices. The 
integration supports MXF files by rewrapping them in AAF as they are brought into Avid shared 
storage through the Interplay Transfer Engine server. The integration supports IMX 30, 40, 50, 
and DVCAM in PAL and NTSC.

Unlike other DHM implementations, this does not enable users to “Send to Playback,” which 
would have allowed initiating requests from the editor that was writing to the decks. 

The following sections give general procedures for capturing clips from a FTP deck device and 
workflows.

• Workflow For Using Sony XDCAM SD and XDCAM HD FTP Devices

• Capturing Clips From FTP Devices
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• Workflow: Capturing Clips From an e-VTR Device

• Workflow: Capturing Clips From an XDCAM Device

Workflow For Using Sony XDCAM SD and XDCAM HD FTP Devices

You can use an Avid editing application to import Sony XDCAM SD and HD material. You can 
also use the Avid editing application to export (write back) your finished sequence back to the 
XDCAM device.

In an Interplay Production environment, you can also use Interplay Transfer and the FTPClipList 
application to capture media from an XDCAM SD and XDCAM HD camera or deck and send 
the material to shared storage. The background transfer capability off loads processor-intensive 
transfers from an Avid editing system. When importing XDCAM SD and XDCAM HD media, 
the master clips are automatically checked into the Interplay Production database. XDCAM 
devices can only transfer one file at a time.

You can use Interplay Transfer to write back XDCAM SD material. For writeback of XDCAM 
HD, use the Export XDCAM feature in the Avid editing application.

c When you are working with XDCAM media, Avid strongly recommends that you use 
distinctive clips names when recording through an XDCAM device. You set these clip 
names on the XDCAM device itself. Avoid the default clip names or other generic names, 
because after you import or ingest the clips, the clips names are used for relinking. If two 
clips share a clip name and timecode, they might relink incorrectly. This relinking issue can 
also affect archive and transcode workflows using XDCAM media.

For information about the playback workflow, see “Workflow: Playing Back to an FTP Server” 
on page 134.

n When you are capturing media from an XDCAM device using FTP, 24-bit audio files are 
captured to the Avid editing system as 16-bit audio files.

FTP capture of XDCAM HD 24p is not supported. You can use the Firewire capture method. For 
details, search for “Connecting the XDCAM Device” in the Help for your Avid editing 
application.

For more information about using XDCAM media, see the following:

• For information about setting up Interplay Transfer and using and FTPClipList, see the 
“Configuring Ingest From FTP Deck Devices” on page 104.

• For information about the XDCAM export feature, see the Help for your Avid editing 
application.
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Capturing Clips From FTP Devices

There are two methods for capturing media from an FTP device:

• Drag and drop items to an Avid editing application bin

• Direct Capture lets an Interplay Transfer client capture media from a FTP device into a 
default workgroup and workspace. The destination of the captured items is set when you 
configure the workgroup and workspace in the Avid Interplay Transfer Engine 
Configuration tool. This workflow provides unattended ingests of selected items. The 
transferred items are added to the Media Tool where you can drag and drop the item to a bin.

To capture clips from a FTP device:

1. From the Avid editing system, set the connection settings for the device. 

See “Setting the Ingest Device Connection” on page 107.

2. (Option) When using the drag and drop method, open a bin or create a new bin and position 
it in an unobstructed area.

3. (Option) Open the Transfer Status window by selecting Transfer > Status Window.
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4. Click the Start button, and select All Programs > Avid > Utilities > FTPClipList.

The FTPClipList dialog box opens. 

5. Select the device you want to use from the Select Device menu.

6. Click Refresh List to view a list of the clips available from the device.

n If the device is busy, the list of available clips does not display.

7. (Option XDCAM) Select Ingest Essence Marks to include the Essence Marks with the 
metadata when capturing XDCAM media.

8. (Option XDCAM) In the “XDCAM will send” area, select one of the following:

- Clips - select to capture the high-resolution of the selected clips.

- Proxy AV - select to capture the low-resolution of the selected clips.
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9. (Option) When using Direct Capture method, you need to configure the Interplay Transfer 
client. 

See “Configuring the Interplay | Transfer Client For Direct Captures” on page 94.

10. Select the clips you want to transfer.

11. Begin the transfer by doing one of the following:

t Drag and Drop method—drag the clips you want to capture to a bin.

A dialog box opens asking if you want to transfer the files now or defer the process to a 
later time. Click Now to begin the transfer or click Later to defer the transfer to a later 
time.

t Direct Capture method—click Initiate Transfer.

The selected items begin transferring one at a time. When the transfer begins the 
FTPClipList title bar displays the destination for the captured items. The destination is 
set when you configure the workgroup and workspace in the Interplay Transfer Engine 
Configuration tool.

12. Monitor the transfer progress using the Transfer Status column. 

The Transfer Status column displays Submitted, Pending, or a percentage of the completed 
capture, as the transfers are monitored every 2 seconds.

Workflow: Capturing Clips From an e-VTR Device

To capture clips from an e-VTR device:

1. Make sure the e-VTR device is properly connected and configured (for more information, 
see the documentation that came with your device) by setting the following:

- Signal standard - NTSC or PAL

- Bit rate - IMX or DVCAM

- Network settings - IP address, network mask, default Gateway

2. Make sure the “Interplay Transfer Engine with Supplemental FTP Services” setting was 
selected as the installation type during the installation of the Interplay Transfer Engine 
application. 

See “Installing the Interplay | Transfer Engine in a Workgroup Environment” on page 26.
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3. Make sure the Interplay Transfer Engine server is configured with the e-VTR device:

a. On your Interplay Transfer Engine server, click the Start button, and then select 
Programs > Avid > Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration window opens.

b. In the Ingest area, click Add. 

The Device dialog box opens.

c. Type the name associated with the e-VTR device on the network, for example evtr_wu, 
and then click OK.

d. Make sure the Workgroup Settings are set correctly. See the table in “Installing the 
Interplay | Transfer Engine in a Workgroup Environment” on page 26.

e. Click Save.

4. Make sure the e-VTR device is configured in the e-VTR Manager application. 

See the documentation that came with your device. Set the following:

- Network device register - config name, host/IP address

5. Set up the device connection from the Avid editing system. 

For the setup procedure, see “Setting the Ingest Device Connection” on page 107.

6. Connect to the e-VTR device using the e-VTR Manager application. 

See the documentation that came with the device.

7. Start the capture. See “Capturing Clips From FTP Devices” on page 137.

When the transfer is complete, the clip appears in the bin.

Workflow: Capturing Clips From an XDCAM Device

To capture clips from an XDCAM device:

1. Make sure the XDCAM device is properly connected and configured; see the documentation 
that came with your device. Set the following:

- Signal standard - NTSC or PAL

- Bit rate - IMX or video

- Network settings - IP address, network mask, default Gateway

2. Make sure the “Interplay Transfer Engine with Supplemental FTP Services” setting was 
selected as the installation type during the installation of the Interplay Transfer Engine 
application. 

See “Installing the Interplay | Transfer Engine in a Workgroup Environment” on page 26.
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3. Make sure the Interplay Transfer Engine server is configured with the XDCAM device:

a. On your Interplay Transfer Engine server, click the Start button, and then select 
Programs > Avid > Interplay Transfer Engine Configuration.

The Interplay Transfer Engine Configuration window opens.

b. In the Ingest area, click Add.

c. In the Device dialog box, type the name associated with the XDCAM device on the 
network, for example xdcam_wu, and then click OK.

d. Make sure the Workgroup Settings are set correctly. See the table in “Installing the 
Interplay | Transfer Engine in a Workgroup Environment” on page 26.

e. Click Save.

4. Make sure the XDCAM device is configured correctly. 

See the documentation that came with your device. Set the following:

- Set the FTP registration by adding a host name and IP Address for the XDCAM.

- Connect to the FTP device by typing a user name and password.

5. View the media on the XDCAM device. See the documentation that came with your device.

6. Set up the device connection from the Avid editing system. 

For the setup procedure, see “Setting the Ingest Device Connection” on page 107.

7. Start the capture. See “Capturing Clips From FTP Devices” on page 137.

When the transfer is complete, the clip appears in the bin.



5 Using Frame Chase Editing

This chapter describes how to use Frame Chase editing. Frame Chase editing (sometimes called 
“edit while capture” or EWC) lets an Avid editing application that is part of an Interplay 
workgroup view and edit clips while they are being captured. Frame Chase editing is supported 
only when media is captured from a supported external device through Interplay Transfer.

This chapter includes the following topics:

• Understanding Frame Chase Editing

• Workflow for Frame Chase Editing

• Using Frame Chase Editing

• Limitations When Working With In-Progress Clips

Understanding Frame Chase Editing
Frame Chase editing is a time-saving feature that lets an editor view and edit media while it is 
being captured from a line feed or ingest device. After the capture starts, the editor can use the 
captured media to create a sequence, view the media as it is captured, and complete a sequence 
even before the capture has finished. 

Clips that are in the process of being captured are referred to as in-progress clips. In-progress 
clips are indicated by the following icons:

When the capture is complete, the icon is replaced by the standard master clip or audio clip icon. 
To view the updated icon in the Interplay Window, press F5. To view the updated icon in a bin, 
select Bin > Update from Interplay.


In-progress master clip


In-progress audio clip
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Frame Chase editing is available only in an Interplay workgroup that includes Interplay Transfer 
and a supported external device. Media must be in the MXF format. The process consists of three 
basic parts:

1. A capture is started on a line feed or ingest device (for example, an Avid AirSpeed video 
server). This capture is controlled by an application such as Avid CaptureManager™. 
Depending on the device, you can also “hot record” a clip by using controls on the device 
itself.

2. After the capture begins, the Interplay Transfer client on the ingest device communicates 
with the Interplay Transfer server to check the in-progress clip into the Interplay database. 
Interplay Transfer also manages the transfer of media to Avid shared storage. 

3. The editor or journalist loads the in-progress clip. You can work with in-progress clips on an 
Avid editing system, Avid Instinct, or Interplay Assist. On an Avid editing system, you can 
work directly from the Interplay window, or you can check out a clip to a bin.

The following diagram illustrates these basic parts of the process.

The capture 
application starts 
the capture.

Interplay Transfer 
checks in the clip.

CaptureManager

AirSpeed with 
Interplay Transfer 
client

Interplay Transfer 
server

Unity shared storage Avid editing system

The editor loads 
the in-progress 
clip.

33

1

2

The length of an in-progress clip is based on the expected duration of the capture. For on-the-fly 
or open-ended captures, the length of the clip is based on the maximum capture time set by the 
capture application. The Frame Chase process creates one media file for each track of the 
captured media. As a capture continues, the size of the associated media file increases. After the 
capture is complete, the clip is updated to reflect the actual duration of the capture and the 
in-progress icon is replaced by the standard icon.
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n The default duration on an AirSpeed server is one hour (01:00:00:00). When the capture is 
complete, the duration is updated. If a clip goes beyond one hour, the default duration is two 
hours (02:00:00:00).

Frame Chase editing is supported in a dual-ingest configuration, in which both a low-res and a 
high-res version of a clip is created. When an editor loads an in-process clip, the version that is 
displayed is determined by one of the following:

• If dynamic relink is enabled, the dynamic relink settings determine which version is 
displayed.

• If dynamic relink is not enabled, the latest version checked in to the Interplay database is 
displayed.

For more information about dual-ingest configurations, see the Avid CaptureManager 
Installation and Configuration Guide. For more information about dynamic relink, see “Using 
MultiRez and Dynamic Relink” in the Help for your Avid editing system.

Workflow for Frame Chase Editing
The following workflow is one example of how to use Frame Chase editing.

This workflow includes the following components:

• An Avid editing system that is an Interplay Production client. This workflow uses Avid 
NewsCutter Adrenaline. It also uses the Interplay Window to access the Interplay database.

• A supported line-feed or ingest device. This workflow uses an Avid AirSpeed server.

• A capture application. This workflow uses Avid CaptureManager software, which schedules 
the ingest on the AirSpeed server.

•  Interplay Transfer software. In this workflow, the AirSpeed server is an Interplay Transfer 
client and communicates with the Interplay Transfer server.

You can adapt this workflow to suit the requirements of your working environment.
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In the following workflow, an editor uses Avid NewsCutter Adrenaline to create a news story 
from a timed feed. CaptureManager has been set up to work with an AirSpeed server to 
automatically create clips of a set duration from the feed, as shown in the following illustration.

For more information on CaptureManager, see the Avid CaptureManager User’s Guide.



Using Frame Chase Editing

146

Using Frame Chase Editing
To use Frame Chase editing:

1. Make sure that the ingest device is properly connected and set up for recording and transfer.

2. On the Avid editing system, make sure an Avid shared storage workspace is mounted. 

3. Open the Avid editing application, open a project, and open the Interplay Window.

4. In the Interplay Window, navigate to the folder that holds the clip that you want to use for 
editing. 

If you know some information about the clip, you can use the Search feature.

A clip that is being captured displays an in-progress icon.

In-progress 
master clip
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5. Load the clip into the Source monitor and play the clip.

The clip plays in the Source monitor at the same time the media is being captured.

n Portions of a clip that are not currently available display a “Capture in Progress” slide until the 
sections are captured.

In Avid Instinct or Interplay Assist, press F5 to update the media displayed in the monitor.

6. Create a sequence in a bin on your Avid editing system.

7. Use standard editing techniques to build a sequence from the in-progress clip.

8. When the clip is completely captured, select Bin > Update from Interplay. 

This command ensures that the latest version of the clip is used in your sequence. For more 
information, see “Updating Remote Assets in a Bin” in the Help for your Avid editing 
system.

9. Save the sequence and prepare it for playback.

Limitations When Working With In-Progress Clips
During the Frame Chase capture process the final length of the clip is unknown until the capture 
is complete and the clip information is updated. Because of this, there are some limitations when 
you work with in-progress clips.
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You can use the following editing functions only when you are working with the available 
captured media of an in-progress clip:

• Editing in-progress clips into a sequence — You can edit the captured portions of 
in-progress clips into a sequence. 

• Subclips — When creating a subclip from an in-progress clip, you must place the IN and 
OUT points where media has already been captured and is available.

• Trimming — The right-side trim limit of an in-progress clip is determined by the currently 
available media. When you trim an in-progress clip to the end of available media, the trim 
functions as if it had reached the end of the clip. As more media is captured, the trim limit 
increases. Performing the trim at a later time might allow more trimming because more 
media might become available.

The following editing functions are not available when you are working with in-progress clips:

• Clip duplication — Duplication of an in-progress clip is not allowed because the duplicated 
clip loses its relationship with the original in-progress master clip.

• Group clips — You cannot use an in-progress clip in a group clip, because the length of an 
in-progress clip is unknown until the capture is complete. Group clips are based on the 
length of the contributing clips. This limitation applies to all of the related grouping 
operations, such as AutoSync, Group Clips, and MultiGroup.

• Consolidate, Transcode, and Audio Conversion — You cannot consolidate, transcode, or 
perform audio conversion with an in-progress clip. All the media must be available and the 
length of the clip known before you can perform these functions. However, you can 
consolidate and transcode subclips and sequences that reference or contain in-progress clips. 
In these cases, any right-side handles are restricted by the known media duration of the 
in-progress clip at the time of the operation. 

For example, if you set 2-second handles but there is only 1-second of media available for a 
handle at the time the consolidate or transcode operation is executed, then the right-side 
handle is restricted to 1 second.

• Decompose — The restrictions for decompose are the same as consolidate and transcode. 
The right-side handles cannot exceed the known media duration of the clip.

• Non-Check-in export — You cannot export an in-progress clip or a sequence that contains 
in-progress clips because the final clip length might be different than the clip length at the 
time of the export.

• Variable-bit-rate media — The only variable-bit-rate (variable-frame-size) media 
supported for Frame Chase editing is low-res long-GOP MPEG-2 media captured by the 
Avid Interplay low-res encoder. Only media captured by supported ingest devices is 
supported for Frame Chase editing.  

• Using the Capture tool — Frame Chase editing is not available on an Avid editing system 
that is using the Capture tool to capture media. 



6 Monitoring Transfers

You can monitor the transfer of items from an Avid editing application, Avid Interplay Access, or 
the Avid Interplay Administrator software. If you monitor transfers from within the Avid editing 
application, you see only the assets you transferred. If you open the Interplay Transfer Engine 
Status window from the Avid Interplay Administrator, you can monitor all Interplay Transfer 
Engine activity. If you have administrative privileges or you initiated the transfer, you can cancel, 
retry, pause, or resume transfers.

You can also monitor transfers from a standalone system using the Interplay Production Services 
and Transfer Status tool. For more information about Media Services and Transfer Status tool, 
see “Configuring a Standalone System to Monitor Transfer Status” on page 65.

See the following topics:

• Monitoring Transfers from Within the Avid Editing Application

• Monitoring Transfers from Within Interplay | Access

Monitoring Transfers from Within the Avid Editing 
Application

After you transfer an asset from within the Avid editing application, you can monitor 
the transfer.

To monitor the asset transfer:

1. Display the Transfer Status window by doing one of the following:

t For the Avid Instinct and Interplay Assist applications, select File > Interplay Transfer 
Engine > Show Status.

The Interplay Transfer tab displays the transfers.
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t For other Avid editing applications, select Transfer > Status Window.

The Transfer Status window opens.

2. Right-click the status of a particular transfer to display the status options.

See “Transfer Status Window Options” on page 150.

A plus sign in the PWT column indicates the clip or sequence has been set to a high priority.

Transfer Status Window Options

The following table lists the status options available when you right-click a transfer displayed in 
the Transfer Status window during a transfer.

Sorting the Transfer Status Columns

You can sort the transfer status column into either ascending or descending alphabetical order. 
For example, you might want to view the status or locations of the transfers in alphabetical order. 
This makes it easy to view all the completed, paused, or canceled transfers together. 

Status User Options

Transferring Pause or cancel the transfer.

Paused Resume or cancel the transfer.

Error (plus information indicating the error) Retry or clear the transfer.

Pending Cancel the transfer.

Completed or Canceled Clear the transfer.
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To sort a transfer status column:

1. From the Transfer Status window or Interplay Transfer tab, right-click the column to display 
the Sort options.

2. Select either Sort, Sort Reversed, or No Sort. 

Sort lists the information in alphabetical order.

Clearing the Transfer Status Window

When you are using the Transfer Status window from within the Avid editing application to view 
the status of any transfers, you should periodically clean up the Transfer Status window. The 
Transfer Status window is cleared of any leftover status messages when you exit the Avid editing 
application and then restart it. If you have not restarted the Avid editing application in a while, 
and your Avid editing system appears to be sluggish, clear the messages in the Transfer Status 
window.

To clear the Transfer Status window:

1. Do one of the following:

t In the Avid Instinct and Interplay Assist applications, select File > Interplay Transfer 
Engine > Clear Status.

t In the Avid editing application, select Transfer > Status Window. 

The Transfer Status window opens.

2. Press Ctrl+A to select all the items in the Status window.

3. Press Delete.

All the items are removed from the Transfer Status window.
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Monitoring Transfers from Within Interplay | Access
In Interplay Access, you can monitor the transfer activity of all transfers within the workgroup. 
In the Interplay Transfer Engine Status window, several filters are available to help you limit the 
list of transfers displayed in the status window. You can save filter preferences for easy access 
the next time you want to display the same limited list of transfers in the status window.

The following sections provide details about the Interplay Transfer Engine Status window:

• Accessing the Interplay Transfer Engine Status Window

• Understanding the Interplay | Transfer Engine Status Window

• Working with Filters in the Interplay | Transfer Engine Status Window

• Description of Filter Options in the Interplay | Transfer Engine Status Window

Accessing the Interplay Transfer Engine Status Window

To access the Interplay Transfer Engine Status window, do one of the following:

t From Interplay Administrator:

a. Click the Start button, and select All Programs > Avid > Interplay Access Utilities > 
Interplay Administrator.

b. In the Site settings area, click Interplay Transfer Engine Status.

t From Interplay Access, select Tools > Interplay Transfer Status.
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The status window opens and displays the transfer status of all jobs being transferred.

Understanding the Interplay | Transfer Engine Status Window

The Interplay Transfer Engine Status window shows all the current transfer activity. Filters are 
available to limit the number of transfers that display in the Status window. For information 
about using the filters, see “Working with Filters in the Interplay | Transfer Engine Status 
Window” on page 155.

The Status window refreshes periodically to update the status information. You can change the 
default refresh intervals of the Status window. See “Setting the Refresh Time of the 
Interplay | Transfer Engine Status Window” on page 56.

Filters

Status area

Saved 
Filters
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The following table describes the information displayed in the Status area.

Status Area 
Column Description

Status Displays the status of the current transfers.

The color of the status row indicates the following:

• Gray with no icon = Transfer is pending or in the queue.

• Gray with Stop icon = Transfer has been canceled.

• Gray with Pause icon = Transfer has been paused.

• Yellow with no icon = Transfer is running.

• Red with X icon = Transfer has failed.

• Green with check mark icon = Transfer has completed successfully.

Name Shows the name of the media being transferred.

Type Indicates the transfer type: Workgroup pull, Workgroup push, Ingest, Playback.

Source Indicates the name of the workgroup requesting the transfer.

Destination Indicates the name of the workgroup receiving the transfer.

% Complete Indicates the percentage of the transfer that has completed.

User Shows the workgroup and user name requesting the transfer.

Start time Shows the time the transfer was started (not the time the transfer request was 
submitted to the Interplay Transfer server).

Finish time Shows the time the transfer finished.

TapeID Shows the TapeID of a clip, which is the same TapeID used in the Avid editing 
application. This helps identify a particular piece of media.

Transfer Engine Indicates the name of the Transfer Engine performing the transfer.

Transfer Rate Shows the rate of the transfer.

Workspace Indicates the destination workspace of the transfer.

Priority Displays the priority of each transfer.

Error Indicates the reason for transfer failures.
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Working with Filters in the Interplay | Transfer Engine Status Window

The Interplay Transfer Engine Status window provides filters to help limit the number of 
transfers displayed in the status window. You can save filter preferences for easy access the next 
time you want to display the same limited list of transfers in the status window. For descriptions 
of the various filter options, see “Description of Filter Options in the Interplay | Transfer Engine 
Status Window” on page 156.

To set up a transfer filter:

1. Open the Status window. 

See “Accessing the Interplay Transfer Engine Status Window” on page 152.

2. From the Filters area, select the filter options you want to use. 

See “Description of Filter Options in the Interplay | Transfer Engine Status Window” on 
page 156.

The transfers that match your filter options selection display in the status area.

3. (Option) You can save the filter options to use another time by doing the following: 

a. Click Save Current Filter.

The Enter filter name dialog box opens.

b. Type a name for the filter and click OK.

The new filter appears in the list of saved filters for use again.

To use a saved filter:

1. Click Saved filters to display a list of saved filters.
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2. Select the filter you want to use.

3. Click Load to run the filter.

To delete a saved filter:

1. Click Saved filters to display a list of saved filters.

2. Select the filter you want to delete.

3. Press Delete.

Description of Filter Options in the Interplay | Transfer Engine Status 
Window

The various filters let you limit the transfers displayed in the status area. The following table 
explains the filter options.

Transfer Status Filters 

Filter Name Description

Status Select the current status of transfers you want to display: Cancelled, 
Completed, Error, Paused, Pending, Running. 

Source Select the system requesting the transfer.

Destination Select the system receiving the transfer.

Transfer Type Select the type of transfers you want to display: Workgroup pull, 
Workgroup push, Ingest, Playback.



Monitoring Transfers from Within Interplay | Access

157

Transfer Engine Select the Interplay Transfer Engine or Interplay Transfer enabled device 
that is handling the transfer. 

Transfer Engine filter options:

• The Transfer Engine filter parameter lists all Transfer Engines 
configured in the Interplay Transfer Settings view. For information 
about adding Transfer Engines to the filter list, see “Adding 
Interplay | Transfer Engines” on page 53.

• The Transfer Engine filter provides an online/offline status indicator. If 
any Interplay Transfer Engine in the Transfer Engine filter list is 
offline, the filter changes to red. The text (Offline) displays next to the 
Transfer Engine that are offline. 

• When you select a Transfer Engine in the filter list, this only enables 
the status for that Interplay Transfer Engine to display in the status 
area. Therefore, the filter selection has no effect on changing the 
Interplay Transfer Engine’s online or offline state.

Transfer Status Filters 

Filter Name Description

The filter changes to red when 
any Interplay Transfer Engine 
is offline.



7 Troubleshooting

This chapter describes how to detect problems you might encounter when using the Interplay 
Transfer Engine, as discussed in the following topics:

• Suggested Troubleshooting Guidelines

• Verifying Network Connectivity

• Increasing the Performance of Transfers

For additional troubleshooting information, see the Avid shared storage documentation.

Suggested Troubleshooting Guidelines
The following guidelines can help you troubleshoot problems:

• Verify that Interplay Transfer Engine is running on both the sending and the receiving 
systems. Interplay Transfer Engine must be running on both systems.

• Verify that the network cables are securely connected between the computer and the site 
network.

• Verify that the network is operating and that your computer can detect the presence of the 
destination system. See “Verifying Network Connectivity” on page 159.

• If your computer has an optional network board, run the diagnostic programs provided with 
the board to verify that the board is functioning properly.

• If the system times out during transfers to your own computer or any other computer, ask the 
network administrator to verify that the Domain Name System (DNS) server specified in the 
TCP/IP properties of the Network settings in the Control areal is active and connected to the 
network.

• Verify that remote workgroups are configured correctly before performing a 
workgroup-to-workgroup transfer. See “Configuring a Remote Workgroup for 
Workgroup-to-Workgroup Transfers” on page 57.

• View log information using the Interplay Diagnostics. The Interplay Diagnostics is an 
application that lets you view log information stored on either a local or remote computer. 
You can view log information streaming in real time, open logs stored on a remote computer, 
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package remote logs and specify a storage location for them, filter logs by severity, and 
override the logging levels of remote services. For more information, see the Avid Service 
Frameworks User’s Guide.

• Monitor health and status information using the Interplay Health Monitor application. For 
information, see the Avid Service Frameworks User’s Guide.

Verifying Network Connectivity

You can use the Windows operating system ping command to verify the network connection 
between your computer and another system on the network. 

n Before you use the ping command, make sure you know the system name or network address of 
the system you are pinging.

To check network connectivity:

1. Click the Start button, and then click Run. 

The Run dialog box opens.

2. Type the following command in the Open text box:

ping -t systemname

The variable systemname is the name of the system you are verifying.

The Windows Console window opens, showing the status of the pinging. 

3. Press Ctrl+C to stop running the ping command.



Increasing the Performance of Transfers

160

Increasing the Performance of Transfers

You can improve the performance of transfers by changing the file limit of media directories and 
setting the MegaByte multiple factor for read and write operations.

Changing the File Limit of Media Directories

When Interplay Transfer Engine performs capture or heavy workgroup-to-workgroup transfers, a 
single directory can grow to more than 10,000 files. This can cause performance problems. By 
default, when Interplay Transfer Engine starts, it checks the number of files in the Interplay 
Transfer Engine managed directory. If the file count is greater than 95% of 10,000 files, it creates 
a new directory. If you want to lower these values, you must add new parameters to the 
TMserver.ini file.

n File balancing is done only when the Interplay Transfer Engine starts.

The following is a sample of media directories managed by Interplay Transfer Engine:

\\unityFileSystem\workspaceName\Avid MediaFiles \MXF\TM_[tmserverHostname].

During startup only, the Interplay Transfer Engine server checks each media directory for the 
number of files in the directory. If the media directory contains more files than specified by 
FileCountThreshold% of MaxFiles (for example, 95% of 10,000), the Interplay Transfer Engine 
server creates a new directory using the same directory name and appends the name with an 
underscore and an incremental number.

For example, when the directory:

\\Unity1\WS1\Avid MediaFiles\MXF\TM_TransServer

becomes full, the next time the Interplay Transfer Engine server TransServer is restarted, it 
creates a new directory named:

\\Unity1\WS1\Avid MediaFiles\MXF\TM_TransServer_1

and then _2, _3, and so on.
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To change the file limit of media directories managed by Interplay Transfer Engine:

1. Open the file C:\WINDOWS\TMserver.ini using WordPad.

2. In the [PMR Scan] section of the TMserver.ini file, add the following fields.

Additional File Count Logging

The Interplay Transfer Engine server startup logging includes file count information. During 
startup, the Interplay Transfer Engine server lists all the media directories on Avid shared 
storage. Each directory managed by the Interplay Transfer Engine server is listed with three 
asterisks before it; each secondary directory has three hyphens before it. For all directories 
managed by Interplay Transfer Engine, the number of files per directory is displayed.

In addition, a display of these PMR primary and secondary directories is included in the 
Interplay Transfer Engine server’s dump command.

Increasing the Performance of Workgroup-to-Workgroup Transfers

Before performing workgroup-to-workgroup transfers and playback transfers you need to set the 
type of storage you are using for the transfers. You get better transfer performance when you 
select a storage type that matches your environment.

n After you install or upgrade the Interplay Transfer Engine application, the first time you open the 
Interplay Transfer Engine Configuration tool you must select a storage type to use with 
workgroup-to-workgroup transfers and playback transfers.

Fields Added to 
[PMR Scan] section Description

FileBalancing=1 FileBalancing – Turns off and on the feature for limiting the 
number of files allowed in a media directory. If FileBalancing is 
not present in the TMserver.ini file, the default is 1, indicating 
the feature is active.

MaxFiles=100 MaxFiles – Specifies the maximum number of files allowed in 
an Interplay Transfer Engine media directory. If MaxFiles is not 
present in the TMserver.ini file, the default is 10,000 files.

FileCountThreshold=50 FileCountThreshold – Specifies, as a percentage, the file count 
threshold, over which the Interplay Transfer Engine server 
creates a new media directory on its next startup. If 
FileCountThreshold is not present in the TMserver.ini file, the 
default is 95%.
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To set the storage type used for workgroup-to-workgroup and playback transfers:

1. Open the Interplay Transfer Engine Configuration tool.

t Click the Start button, and select Programs > Avid > Interplay Transfer Engine 
Configuration.

2. In the System Settings area, select a storage type from the Storage Type menu.

3. Click Save on the Interplay Transfer Engine Configuration tool and restart the Interplay 
Transfer Engine application.

n If you have less than 2 GB of RAM on your system, the software will automatically limit your 
buffer size to 8 MB.

Storage Type Menu Item Buffer Size

Avid ISIS v1.x ISIS 1.x 8MB

Avid ISIS v2.x (ISIS 7000) ISIS 2.x 16MB

Avid ISIS v3.x (ISIS 5000) ISIS 3.x 16MB

Standalone Interplay Transfer Standalone 8MB



 A C D E F G H I J K L M N O P Q R S T U V W X Y Z

A
Accepting transfers 69
Accessing

Avid FTP Media Browser tool 90
Interplay Transfer Engine Configuration tool 36

AirSpeed server
Frame Chase editing with 144
Interplay Adapter, installing 29
monitoring transfers 55
user account 21

Ancillary data
filtering before playback 83

AutoTransfer
assets 123
checklist 122
identify folder 122
rules 123

AutoTransfer service
configuration 112
installing 29

Avid
online support 6
training services 6

Avid applications
media compatibility between 116

Avid editing system
ingest device connection setup 107
setting up 69

Avid Health Monitor 158
Avid Service Frameworks

troubleshooting tool 158
Avid Unity environment

supported Interplay Transfer configurations 9
Avid Unity ISIS client software

installing 24

C
Capture

editing during 142
Frame Chase editing 142
Omneon directory profile 102

Capture clips
e-VTR device 139
FTP devices 137
XDCAM device workflow 140

CaptureManager
Frame Chase editing with 144

Capturing clips
FTP servers 131

Catalogs
configuring for ingest devices 109
configuring for playback devices 111

Check list
installing and configuring a standalone environment 

22
installing and configuring Interplay Transfer Server 

21
installing support software 23
Thunder server configuration 104

Clips
transferring 117

Commands
ping 159

Compatibility of media 116
Configurations

adding FTP ingest device 102, 105
for MXF DHM OP1a file format transfers 74
FTP deck device capture 104
FTP ingest devices 90
FTP playback devices 82
FTP server 75

Index



Index  A C D E F G H I M N O P R S T U V W X 

164

FTP server, FTP playback, and FTP ingest devices 
74

ingest device catalog 109
Interplay Transfer Engine 35
Interplay Transfer site settings 49
playback device catalog 111
standalone environment 68
supported Interplay Transfer 9
Thunder MX Production server 104
Thunder server ImportWatcher folder 104

Connecting
to an Ethernet network 12

D
Data

transferring in a standalone environment 124
Destination

in Status window 154
Detecting problems 158
Direct capture

configuring TM client 94
FTP devices 137
FTP servers 131

Direct Transfers
adding Interplay Transfer Engines 60
performing 63

Dual-ingest configuration
Frame Chase editing 142

DVCAM 135

E
Edit while capture

See Frame Chase editing
Editing

during capture 142
Ethernet network 8
Ethernet services 12

F
Fibre Channel network 8
Frame Chase editing

described 142
dual-ingest configuration 142
limitations 147

overview 142
workflow 144

Frameworks
troubleshooting tool 158

FTP Clip List
utility 107

FTP deck devices
capture configuration 104
transferring files 135

FTP devices
capturing clips 137

FTP Directory profiles
creating 90

FTP ingest devices
adding 105
adding Omneon 102
configuration 74, 90
connection 107

FTP Media Browser dialog box 131
FTP playback devices

configuration 74, 82
FTP servers

configuration 74, 75
ingesting clips workflow 131
play back workflow 134
Thunder server configuration 104

FTPClipList dialog box 137

G
Generic FTP servers

transferring files 130
Guidelines

for troubleshooting 158

H
Hardware

installing the Interplay Transfer server 20, 21

I
ImportWatcher folder

setup 104
Ingest

configuration FTP deck devices 104
FTP devices 137



A B C D E F G H I M N O P R S T U V W X Index

165

Ingest device
catalog configuration 109
transferring files from 128

In-progress clips
editing during capture 142
limitations 147

Installing
Avid Unity ISIS client software 24
Interplay Production Services and Transfer Status 

tool 30
Interplay Transfer client software 34
Interplay Transfer Engine software 26
Interplay Transfer server hardware 20, 21

Interplay Diagnostics
troubleshooting 158

Interplay Production Services and Transfer Status
configuring 65
installing 30

Interplay Transfer Engine
configuration 35
monitoring transfers 53

Interplay Transfer Engine Configuration tool
configure FTP settings 36
DET settings 36
ingest settings 36
opening 36
playback settings 36
playlist settings 36
settings 36
standalone settings 36
system settings 36
total transfer settings 36
workgroup settings 36
workgroup transfer settings 36

Interplay Transfer Engines
adding to workgroup 60

Interplay Transfer server
installing 20, 21

Interplay Transfer settings
opening, Avid editing application 50

Interplay Transfer Status Window
set refresh 56

M
Media compatibility 15, 116
Monitor

AirSpeed transfers 55
refresh Interplay Transfer Status window 56
select Transfer Cache engine 52
transfer setup 49
transfer status 30, 65
transfer status on standalone system 67

Monitoring transfers 149
MXF DHM OP1a file format

filtering ancillary data 83
third-party devices 130
transfer configuration 74

MXF media support 15

N
Name

in Status window 154
Network

board 158
detecting presence on 159

Network connectivity 158
Networking considerations

between workgroups 12
firewalls 12
port numbers 12
remote workgroup 13
services 12
typical configuration 13

O
Online support 6
Optimize performance 161

P
Password, setting 112
Performance optimize 161
ping command 159
Play while transfer

for XDCAM HD 128
Playback devices

catalog configuration 111
transferring files to 124

Playback Format
FTP profile option 75

Presence on the network



Index  A C D E F G H I M N O P R S T U V W X 

166

detecting 159
Presets

creating for transfers 47
Priority

in Status window 154
Problems

detecting 158
Procedures

configuring Avid services 112
Profiles

creating FTP directory 90, 102
FTP servers 75
Omneon creating 100
XDCAM SD 96, 97

Progress indicator
in Status window 154

R
Refresh

Interplay Transfer Status window 56
Remote workgroup connectivity

rules 12
typical configuration 13

Rundowns
working with 125

S
Schedules

working with 125
Send to Playback

accelerated for XDCAM HD 128
Send to Workgroup Settings

description 119
Setting passwords, system configuration service 112
Setting up the Avid editing system 69
Settings list 69, 72
Site settings

Interplay Transfer 49
Software

Avid Unity ISIS client
installing 24

Interplay Adapter
installing 29

Interplay Production Services and Transfer Status 
tool 29

Interplay Transfer Engine
configuration 35
installing 26

Sony XDCAM FTP devices
workflow 136

Sorting transfers 150
Standalone environment

configuration 68
using Interplay Transfer in 123

Standalone Interplay Transfer
supported configurations 9

Standalone system
monitoring transfers 30, 65, 67

Start
in Status window 154

Starting
Interplay Transfer server 23

Status window
described 153

Storage Type option 161
Studio

monitoring transfers 55

T
TapeID

in Status window 154
Third-party devices

interoperability 130
MXF OP1a files 130

Thunder server
adding 104
configuration check list 104
configure FTP server software 104
ImportWatcher folder setup 104

Timing out during transfers 158
TM Client

configuration 94
Total Transfers

setting 45
Training services 6
Transfer Presets

creating 47
Transfer Rate

in Status window 154
Transfer settings

in an Avid editing application 69



A B C D E F G H I M N O P R S T U V W X Index

167

in an Avid Unity environment 72
maximum number 45

Transfer Status window 152
Transfer types 14
TransferManager client

configuration 94
Transferring assets

Direct Transfers 63
Transferring files

automatically 121, 123
AutoTransfer checklist 122
from an ingest device 128
from one workgroup to another workgroup 117, 119
from within an Avid application 117
from within an Avid editing application 124
FTP deck devices 135
Generic FTP servers 130
identify AutoTransfer folder 122
to a playback device 124
Workgroup 4.5 to Interplay 120

Transfers
method of accepting incoming 69
monitoring 149
monitoring from Interplay Transfer Status window 

152
MXF DHM OP1a file format 74
setting up the Avid editing system for 69
sorting 150

Troubleshooting 6, 158
Type column

in Status window 154

U
User account

AirSpeed server 21
Utilities

Avid FTP Media Browser tool 90
FTPClipList 107

V
Verifying network connectivity 159

W
Workflow

capture from e-VTR device 139
capture from XDCAM device 140
ingesting clips from FTP server 131
play back FTP server 134
Sony XDCAM FTP devices 136

Workgroup 4.5
transferring files from 120

Workgroup environment
Interplay Transfer in 8
remote workgroup network configuration 13
typical configuration with Interplay Transfer 8

Workgroup Transfer Presets
creating 47

X
XDCAM FTP devices

workflow 136
XDCAM HD

profile creating 100
XDCAM SD

FTP server profile 96, 97
playback configuration 96, 97



Avid
75 Network Drive
Burlington, MA 01803-2756 USA

Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support

Product Information
For company and product information, 
visit us on the web at www.avid.com


	Title Page
	Contents
	Chapter 1 Interplay | Transfer Overview 7
	Chapter 2 Interplay | Transfer Installation 20
	Chapter 3 Interplay | Transfer Configuration 35
	Chapter 4 Transferring Avid Assets 116
	Chapter 5 Using Frame Chase Editing 142
	Chapter 6 Monitoring Transfers 149
	Chapter 7 Troubleshooting 158
	Using This Guide
	Symbols and Conventions
	If You Need Help
	Avid Training Services

	Interplay | Transfer Overview
	Understanding Interplay | Transfer Engine Configurations
	Workgroup Configurations
	Supported Interplay | Transfer Configurations

	Networking Considerations
	Remote Workgroup Connectivity Rules
	Typical Configuration
	Remote Workgroup Network Configuration

	Transfer Types
	Support for MXF/AAF Media
	Operating Points Qualified for Interplay | Transfer Playback

	Interplay | Transfer Installation
	Installation and Configuration Check List
	Check List for Installing and Configuring an Interplay | Transfer Engine Server
	Check List for Installing and Configuring an Interplay | Transfer Engine in a Standalone Environment
	Check List for Installing Interplay | Transfer Engine Support Software

	Turning On the Interplay | Transfer Engine Server
	Installing Avid Shared Storage Client Software
	Understanding the Software Required for Performing Transfers
	Understanding the Workgroup Environment Software
	Understanding the Standalone Transfer Environment Software

	Installing the Interplay | Transfer Engine in a Workgroup Environment
	Installing the Interplay | Transfer Engine Software
	Installing the Interplay | Transfer Engine Client Software

	Installing Interplay | Transfer Engine Support Software
	Installing the Interplay | Auto Media Services Service
	Installing the Interplay | Production Services and Transfer Status Tool
	Installing the Transfer Cache Engine

	Installing the Interplay | Transfer Engine Software in a Standalone Environment
	Installing the Interplay | Transfer Engine on a Standalone Editing System
	Installing the Interplay Transfer Engine Client Software in a Standalone Environment


	Interplay | Transfer Configuration
	Opening the Avid Interplay | Transfer Engine Configuration Tool
	Interplay | Transfer Engine Configuration Settings
	Setting the Number of Simultaneous Transfers Allowed by the Interplay | Transfer Engine
	Configuring Workgroup Transfer Presets
	Configuring an Interplay | Production Workgroup For Transfers
	Opening the Interplay | Transfer Engine Settings View
	Selecting a Transfer Cache Engine for Monitoring Transfers
	Adding Interplay | Transfer Engines
	Adding an Avid AirSpeed Studio
	Setting the Refresh Time of the Interplay | Transfer Engine Status Window

	Configuring a Remote Workgroup for Workgroup-to-Workgroup Transfers
	Specifying Interplay | Transfer Engines for Direct Transfers
	Configuring a Workgroup for Direct Transfer
	Creating a Transfer Preset
	Performing a Direct Transfer

	Configuring a Standalone System to Monitor Transfer Status
	Monitoring Transfer Status from a Standalone System

	Configuring Interplay | Transfer Engine in a Standalone Environment
	Configuring the Avid Editing Application for Transfers
	Setting Transfer Settings in the Avid Editing Application
	Multi-Channel Mapping for Send to Playback
	Allowing Transfers to Other Workgroups and Workstations

	Configuring Capture and Playback of MXF DHM OPIa File Formats
	Configuring an FTP Server Profile
	FTP Server Dialog Box Settings Used to Create an FTP Server Profile
	Setting an Aspect Ratio For Send To Playback
	Configuring OP1A/XDCAM Profiles for Catalog Checkins
	Configuring a Generic FTP Playback Device into a Workgroup
	Filtering Ancillary Data During Send to Playback
	Creating Transfer Engine Tape IDs for STP Transfers
	Writing to a Temp File with Generic FTP profiles
	Configuring a Generic FTP Ingest Device into a Workgroup
	Creating and Editing FTP Directory Profiles on Interplay | Transfer Client
	FTP Directory Profile Window Settings
	Configuring the Interplay | Transfer Client For Direct Captures
	Configuration for Playing Back to a Sony XDCAM SD Device

	Configuration for Playing Back to a Sony XDCAM SD Device
	Configuration for Working with XDCAM HD and XDCAM EX Assets
	Configuration for Working with an Omneon Server
	Configuration for Working with an AirSpeed Multi Stream Server

	Configuring a Thunder Production Server
	Configuring Ingest From FTP Deck Devices
	Adding FTP Ingest Devices into an Interplay | Transfer Engine Configuration
	Setting the Ingest Device Connection
	Connection Settings For Ingest Device

	Configuring an Ingest Device Catalog
	Configuring a Playback Device Catalog
	Configuring the Interplay | Auto Transfer Service

	Transferring Avid Assets
	Media Compatibility Between Avid Applications
	Transferring Avid Assets from an Avid Editing Application
	Transferring Avid Assets from an Interplay | Production Workgroup to Another Workgroup
	Explanation of Send to Workgroup Settings
	Transferring Avid Assets from Workgroup 4.5 to an Interplay | Production Workgroup

	Automatically Transferring Assets to Another Workgroup
	Check List for Automatic Transfer
	Identify an AutoTransfer Folder
	Automatically Transferring Assets
	Rules of AutoTransfer

	Transferring Avid Assets in a Standalone Environment
	Transferring Avid Assets to Another Avid Editing System

	Transferring Avid Assets to a Playback Device (Send to Playback)
	Working with Rundowns
	Creating a Rundown Schedule File
	Transcoding of Mixed Resolution Clips During a Send to Playback
	XDCAM HD Send to Playback Acceleration

	Transferring Files From an Ingest Device
	Transferring To and From Generic FTP Servers
	Workflow: Capturing Clips From an FTP Server
	Workflow: Playing Back to an FTP Server

	Transferring Files From FTP Deck Devices
	Workflow For Using Sony XDCAM SD and XDCAM HD FTP Devices
	Capturing Clips From FTP Devices
	Workflow: Capturing Clips From an e-VTR Device
	Workflow: Capturing Clips From an XDCAM Device


	Using Frame Chase Editing
	Understanding Frame Chase Editing
	Workflow for Frame Chase Editing
	Using Frame Chase Editing
	Limitations When Working With In-Progress Clips

	Monitoring Transfers
	Monitoring Transfers from Within the Avid Editing Application
	Transfer Status Window Options
	Sorting the Transfer Status Columns

	Monitoring Transfers from Within Interplay | Access
	Accessing the Interplay Transfer Engine Status Window
	Understanding the Interplay | Transfer Engine Status Window
	Working with Filters in the Interplay | Transfer Engine Status Window
	Description of Filter Options in the Interplay | Transfer Engine Status Window


	Troubleshooting
	Suggested Troubleshooting Guidelines
	Verifying Network Connectivity
	Increasing the Performance of Transfers
	Changing the File Limit of Media Directories
	Increasing the Performance of Workgroup-to-Workgroup Transfers
	A
	C
	D
	E
	F
	G
	H
	I
	M
	N
	O
	P
	R
	S
	T
	U
	V
	W
	X




